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Foreword

Computer Software Copyrights

The Motorola products described in this uset’s guide include a
copyrighted Motorola computer program. Laws in the United States and
other countries, as well as International Treaties, preserve for Motorola
the exclusive rights for Motorola’s copyrighted computer programs,
including the exclusive right to copy, reproduce, distribute, or otherwise
transfer said computer program(s). Accordingly, the copyrighted
Motorola computer programs contained in this user’s guide may not be
copied, decompiled, reverse engineered, disseminated, distributed,
disassembled, modified, adapted, used to prepare derivative works or
reproduced in any manner, on or within any media without the express
written permission of Motorola. Furthermore, the purchase of Motorola
products shall not be deemed to grant either directly or by implication,
estoppel, or otherwise, any license under the copyrights, patents, or patent
applications of Motorola, except for the normal non-exclusive, royalty-
free license that arises by operation of Iaw in the sale of a product.

Motorola Limited Hardware Warranty

This warranty for CENTRACOM Gold Series products is provided in lieu
of the Commercial Warranty (Standard} for certain Motorola
mamrfactured products, as set forth in General Information,
CENTRACOM Warranty of the Motorola Electronic Catalog (Domestic
User Price Book). This warranty is extended by Motorola, Inc.. 1301 E.
Algonquin Road, Schaumburg, THinois 60196 to the original end user
purchaser when purchasing for commercial, agricultural or governmental
use. This warranty is not assignable or transferable to any other party and
applies only within the 50 United States.

This plan extends the coverage of the Commercial Warranty (Standard)
from one year parts and 120 days labor to one year parts and one year
1zbor for CENTRACOM Gold Series products, with the first 120 days
labor to be provided on-site, and labor for the remainder of the year to be
provided at the designated depot service center. ALL REFERENCES TO
THE WARRANTY PERIOD BEGIN AT TIME OF ORIGINAL
SHIPMENT.
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. GENERAL PROVISIONS

This warranty sets forth the full extent of MOTOROLA'S responsibilities
regarding the Product. Motorola’s total liability and the purchaser’s sole
remedy for any breach of this Warranty will be limited to, at Motorola'’s
option, repair, replacement or refund of the purchase price of the
product(s). MOTOROLA DISCLAIMS ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL
MOTOROLA BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL
DAMAGES TCO THE FULL EXTENT SUCH MAY BE DISCLAIMED
BY LAW,

. WHAT THIS WARRANTY COVERS

Parts;

All CENTRACOM Gold Series product parts are warranted to be free
from defects in material and workmanship for a period of ONE (1) YEAR
from the date of shipment. Motorola will furnish free of charge parts that
Motorola finds defective within the full warranty period.

Labor:

Labor to repair or replace defective parts within the original shipped
products will be provided for one (1) year from the date of purchase.
Motorola will pay for on-site labor to repair or replace any defective parts
for one hundred twenty (120) days from the date of shipment. For the
remainder of the one (1) year period from the date of shipment, defective
parts must be returned for depot repair.

THIS PLAN DOES NOT COVER defects, malfunctions, performance
failures or damages to the parts resulting from:

Use in other than its normal and customary manner
Misuse, vandalism, accident or neglect; or

Improper disassembly, testing, operation, maintenance, installation,
modification, adjustment, alteration, or repair.

i
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How To Receive Depot Warranty Service

All CENTRACOM Gold Series parts covered by the Warranty for
CENTRACOM Gold Series Products that require depot service must be
sent or taken to the following depot:

Motorola System Support Center
1311 East Algonquin Road
Schaumburg, IL. 60196

Phone: 800-323-9949

Motorola Limited Software Warranty

For the first one hundred twenty (120) days following its initial shipment,
Motorola warrants that, when properly used, its software will be free from
reproducible defects that cause a material variance from its published
specification. However, Motorola does not warrant that program
operation will be uninterrupted or error-free, that each defect will be
corrected, or that any program will meet Licensee’s particular
requirements.

Motorola’s total liability and Licensee's sole remedy for any warranted
software shall be limited to, at Motorola’s option, repair or replacement of
Motorola software or the payment of Licensee’s actual damages, not to
exceed the total licensed charge paid by Licensee to Motorola for the item
of software that caused the damage,

IN NO EVENT SHALL MOTOROLA BE LIABLE FOR SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES (INCLUDING
WITHCUT LIMITATION LOSS OF USE, TIME OR DATA,
INCONVENIENCE, COMMERCIAL LOSS, LOST PROFITS OR
SAVINGS) TO THE FULL EXTENT SUCH MAY BE DISCLAIMED
BY LAW EVEN IF MOTOROLA HAS BEEN ADVISED OF THE
POSSIRILITY OF SUCH DAMAGES OR FOR ANY CLAIM
AGAINST LICENSEE BY ANY OTHER PARTY.

MOTOROLA IS NOT RESPONSIBLE AND SPECIFICALLY
DISCLAIMS ANY AND ALL LIABILITY FOR: (1) ANY
HARDWARE, FIRMWARE OR SOFTWARE PROBLEMS CAUSED
BY CHANGES IN THE OPERATING CHARACTERISTICS OF
COMPUTER HARDWARE OR COMPUTER OPERATING SYSTEMS
WHICH MAY BE MADE TO THE HOST COMPUTER, WHICH
CHANGES ARE MADE AFTER THE RELEASE OF THE
SOFTWARE PRODUCT AND ITS INSTALLATION ON THE HOST
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COMPUTER; (2) ANY HARDWARE, FIRMWARE OR SOFTWARE
PROBLEMS WHICH ARE CAUSED, DIRECTLY OR INDIRECTLY,

BY THE INTERACTION OF THE SOFTWARE PRODUCT WITH
NON-MOTOROLA CENTRACOM GOLD SERIES™ SOFTWARE
PRODUCTS; AND (3) ANY HARDWARE, FIRMWARE OR

SOFTWARE PERFORMANCE PROBLEMS WHICH ARE CAUSED, ()
DIRECTLY OR INDIRECTLY, BY USING NON-MOTOROLA -7
CENTRACOM GOLD SERIES™ SOFTWARE ON THE SAME HOST
COMPUTER WITH THE SOFTWARE PRODUCT.

This warranty extends only to the first licensee; subsequent transferees
accept these programs “as is™ and without warranties of any kind. THIS
WARRANTY IS GIVEN IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING,
WITHOUT LIMITATION, THE WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.

The classification of defects in Motorola supplied software shall be the
responsibility of Motorola. Remedy of defects is at the sole discretion of
Motorola. If Motorola agrees to remedy a software defect, the new
software will be warranted until the end of the original warranty period.

Replacement of any software defect shall constinte Motorola supplying
the customer with the appropriate software media and authorizationkey. { )
Field installation and configuration are not included. ~

All warranty service will be performed at service locations designated by
Motorola. Travel and associated expenses of the Licensee or such
expenses incurred by Motorola for visits to Licensee's location by
Motorola personnel are not covered by this warranty. This warranty does
not cover an item of Software (i) used in other than its normal and
customary manger; (ii) subjected to misuse; (iii) subjected to
medifications by Licensee or by any party other than Motorola without
the prior written consent of Motorola.

For the first 120 days following its initial shipment, Motorola warrants

that the media carrying the software will be free from defects which

damage the performance of the software. Motorola will replace any

damaged media free of charge during the warranty period. Warranted

media is limited to that which is used to transport the software (e.g.

floppy disks and authorization key). PROMs which may store the

software in equipment are covered in the hardware warranty. N
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Field software updates/upgrades and new enhancement option software
will be warranted for one hundred twenty (120) days from the date of
initial shipment.

All special software (“SP”) provided to customers by Motorola will be
warranted as set forth herein.

Documentation Copyrights

No duplication or distribution of this document or any portion thereof
shall take place without the express wriiten permission of Motorola. No
part of this manual may be reproduced, distributed, or transmitted in any
form or by any means, electronic or mechanical, for any purpose without
the express written permission of Motorola. To order additional copies
contact your Motorola sales representative.

©72001, Motorola, Inc. All rights reserved. Printed in U.S.A.

Disclaimer

The information in this document is carefully examined, and is believed
to be entirely reliable. However, no respousibility is assumed for
inaccuracies. Furthermore, Motorola reserves the right to make changes to
any products herein to improve readability, function, or design. Motorola
does not assume any liability arising out of the applications or use of any
product or circuit described herein; nor does it cover any license under its
patent rights nor the rights of others.

Trademark Information

Motorola, the Motorola logo, CENTRACOM™, CENTRACOM Elite™,
CENTRACOM Gold Series™, iDEN™, Digital Voice Privacy™,
DVP™, SmartZone™ are registered trademarks of Motorola, Inc.

Windows NT® and Windows 2000® are trademarks of the Microsoft
Corporation.

Any other brands or product names are trademarks or registered
trademarks of their respective holders.
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FCC Interference Warning

The FCC requires that manuals pertaining to Class A computing devices
must contain a warning about possible interference with local residential
radio and TV reception. This warning reads as follows:

This equipment generates, uses, and can radiate radio frequency encrgy n
and if not installed and used in accordance with the instruction manual,

may cause interference to radio communication. This equipment has been

tested and found to comply with the limits for a Class A computing device
pursuant to Subpart J of Part 15 of FCC Rules, which are designed o

provide reasonable protection against such interference when operated in

a commercial environment. Operation of this equipment in a residential

area is likely to cause interference. In this case users are required, at their

own expense, to correct the interference.

Regional Languages

The CENTRACOM Gold Series Elite and Elite Admin applications
support regional languages. To configure the application to suppott a
regional language, refer to the Motorola Console Regional Language
Support User’s manual which is located on the CENTRACOM Gold
Series CD-ROM.

Read/Write Limitations of Directories and Files

Directories and files may be set-up to have Read Only permissions.
However, for Elite to work properly, the following three directories must
have read/write permissions:

C:\Program Files\CENTRACOM Gold (and sub-directories or any other
directory that was chosen to contain the CENTRACOM Gold files)

C:A\Temp
CAWinnt

For instructions on setting permissions, please refer to your Windows NT
User’s documentation.
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Autostarting Dispatch
Elite Dispatch can be set to startup after a user logs in.

1.

2,

4.

S.

In Windows Explorer, navigate to and open the Startup folder
inside the Programs folder.

Navigate to and open the CENTRACOM Gold folder and locate
the Elite Dispatch program icon.

-? clite.exe

Using the right mouse button click, hold and drag the icon into the

. Startup folder. Select "Create Shortcut(s) Here" from the

appearing window.

Using the right-mouse button Click on the newly created shortcut
and select "Properties” then the Shortcut tab.

In the command line for the shortcut, add the filename of the
configuration file (files that have the extension .elt ) surrounded by
quotation marks ( "filename” ) used by Elite and typically found
in the Config folder of the CENTRACOM Gold folder. Here’s an
example of a command line:

*C:\Program Files\CENTRACOM Gold\bin\elite.exe"
"config.elt”

(There is to be an empty space between elite.exe” and "config.elt”
on the command line in the sample above).
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Getting Help

Please read this mamal before using Elite Admin.

When a program is activated, select the Help menu at the top of the (-\
screen for the Help file to be displayed.

—
If there is a problem loading Admin, or if the console does not appear to

be working properly, refer to the section titled "Troubleshooting,” or

contact the supervisor for help.

To request technical assistance, call the Motorola System Support Center
at:

*  Motorola and MMS - (800) 221-7144

¢ End Users or Customer - (800) 323-9949

Please have the following information ready when calling for technical
assistance:

The Customer name and phone number.

The Service Shop or Provider name and phone number.

A description of the problem.

Any remote dial-up numbers (if applicable).

Serial number of equipment. '
Geld CD-ROM number or CDM/ADM/Elite software version " -
number.

COIM Firmware version.

I upgraded, the Factory order number of the upgrade.

Proof of coverage under warranty, maintenance agreement or a valid
P.O. number for flat rate charge.

Software Products/Software Add-ons

Special Products (SPs)/software "add-ons" may be available and/or
referenced in this manual. For further information or to purchase such
features, contact your authorized Motorola sales representative.
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Chapter 1 Basics

What is a Console?

O

This section provides:
¢ An overview of the CENTRACOM Elite Dispatch system.

¢  An overview of the functions performed through the Admin
application.
e A procedure for starting the Admin application.

e A description of the Admin Graphical User Interface (GUI) screen
components.

e An overview of the application menu commands.

Each operator position in the dispatch center consists of an IBM-
compatible personal computer (PC) and a CENTRACOM Gold Series
Console Interface Electronics (CIE) unit. The PC, while it is running the
Dispatch software, controls the operation of the CIE, The CIE is the
physical equipment interface between the Central Electronics Bank (CEB)
and operator personnel. The CEB contains the equipment that routes
audio between the base stations and the operators. All of the operator PCs
in the dispatch center are connected to each other in a Local Area
Network (LAN) so they can share information.

A block diagram of a typical CENTRACOM radio system is shown on
the following page. An incoming call from a radio in the field is received
by the base station. The base station sends the call to the CEB, where it is
decoded and sent to the operator consoles that are monitoring that radio’s
channel. The Dispatch software then displays the incoming call
information on the PC screen.

The Console Operator Interface Module (COIM) provides the link
between dispatch positions and the CEB. The COIM contains all the
electronics to convert and route andio from the dispatch position and the
CEB TDM (Time Division Multiplex) buses. The COIM’s “personality”
is programmed via the Console Database Manager (CDM) over the LAN.
Aliases are programmed using the Alias Database Manager (ADM) over
the LAN.

Basics
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Admin Overview

The Admin software runs on a PC equipped with a Windows® operating
system. The software creates a virtual desktop on the screcn where
resources that are part of the dispatch system are displayed graphically.
Resources are grouped into folders, and one or more folders are stored as
a configuration.

The system administrator uses the Admin software to set up
configurations for the Dispatch desktops that group resources together in
a logical way.

The system administrator interacts with the Admin software using the
keyboard and a pointing device such as a mouse or a trackball.

The Admin software cannot monitor actual resources; its only purpose is
to set up desktop configurations for use by dispatch operators.

Note: If a feature described in this manual does not appear on the Admin
screen, it may not be available at this dispatch center. Contact the
supervisor if there are questions about the CENTRACOM Gold
Series Elite features that the dispatch center has purchased.
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How to Start and Exit Admin

From Windows, click Start / Programs / CENTRACOM Gold Series /
Elite Admin. The main Elite Admin window displays, with the Welcome
window on top, and the Activity Log below:

The title bar (grayed out at the top) displays the configuration name:
"Untitled - CENTRACOM Elite Admin." Once a configuration is
opened, its name with the extension .ELT will appear here. From the
Welcome window a user selects Open or Create Configuration, or Exit.

Exiting Admin

To exit the Elite Admin application:
1. Choose Exit from the Configuration menu. If changes were made
to the open configuration the program prompts to save changes.

2. Choose Yes to save the changes, No to exit without saving
changes, or Cancel to return to Admin. e

—

14
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Using the Admin Screen
A typical Admin screen is shown below with elements labeled.

- Compressed Resource  Multiselect/Patch

with flap down Group area Auxiliary O
Larger Group YWindow
Folder Tabs Compressed
Resource Tootbar Expanded Clock

Resource

Compressed Evert Displa
Lo h play

Resource with 2 Quick Page Shatus Li

flap up Resource ne
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The screen items are listed below:

Multi-select/ Displays the folders and multiselect or patch window

patch area associated with the selected configuration.

Title bar Shows the name of the configuration currently chosen. (—\
Menu bar Displays the menus available in Dispatch. ~
Toolbar Displays icons representing commonly used menu items.

Folder Tabs Shows all folders in the current configuration, The resources

in the highlighted folder are shown on the desktop.
Radio resource Displays the characteristics and call status of a radio,
Phone resource Displays the characteristics and call status of a telephone.

Resource area Displays all resources in the selected folder. To conserve
screen space, some resources may be compressed. They can
be expanded using the arrow button at the bottom right
corner of the resource window.

Multi-select or Lists the resources in the currently selected multiselect
Patch window (MSEL) or patch group.

Activity log Lists the most recent calls received at the console. This is an
optional display; it may not appear on the monitor.

-

Event Display Lists prioritized and sorted Inbound Radio Message Events
and enables operator interaction. This is an optional
software add-on display; it may not appear on the monitor.

Auxio Allows control of an external device and displays the statns
— usually on/off or open/close — such as a door, light or
alarm, monitored by the control center.

Status line Displays status and error messages. To see a list of the most
recent messages, select the down amrow to the right of the
status line. To close the list, select the arrow again.

System Status Clickable status icons are presented here.

display
Quick page A Quick Page can be sent by clicking the Quick Page button
resource on a resource. If a resource represents a group, pages will be

sent to all members of the group. ﬁ
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Overview of Admin Menus

Configuration Menu

The Configuration menu allows the operator to create new configurations,
open existing configurations to make changes to them, save the changes,
and save the changes as a new configuration.

New Creates new configurations.

Open Displays a list of all configurations to choose from.
The default file extension for CENTRACOM Elite
configuration files is .ELT.

Save Saves changes to a configuration file.

Save As Saves a new configuration which has been created or
saves a changed configuration with a new name.

Exit Closes Admin.

The numbered menu choices below the Save As option are the last four
desktop configuration files that have been opened. The user can quickly
open one of these configurations by selecting it without having to first
click on Open.

Basics

68P81095E70 - G 1-7



Edit Menu

Use the Edit menu to change configuration files in the following ways:

Customize the appearance of resources.

Add or remove resources from folders.

Add or remove resources from Resource Groups.
Edit Auxiliary I/0 Groups.

Edit a Current Configuration.

Edit or Create an Event Display (a software add-on)
Arrange toolbar items.

Configure user preferences.

* . ¢ & & ¢ & 0 0

Selection Description

Resources Sets up the way the resources in a configuration
are displayed; that is, the buttons in a resource
can be arranged.

Folders Assigns resources to folders.
Resource Set up or modifies groups of Primary Resources,
Groups Multiselect or Patch.
Auxiliary /O Launches a dialog box which allows the creation,
Groups... modification and deletion of Auxiliary IO groups
Current Modifies the number and location of patch and
Configuration multiselect groups, and other general
characteristics.
1-8 68P81095670 - G CENTRACOM Elite Admin User's Guide
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Selection

Description

Event Display

Toolbar

Preferences

Enables creation or editing of an Inbound Event
Display interface (an optional software add-on)

Determines which functions appear (and in which
order they appear) on either toolbar 1 or toolbar
2, in each configuration.

The following groups of preferences are
provided:

Activity Log: Allows the changing of the
number of columns, and the information
represented in each of the columns for the
Activity Log.

Augxiliary I/O Window: Launches a dialog box
for Assigning / Deassigning an Auxiliary group
to/from the Auxiliary /O Window and controls
the Auxiliary I/O Window visibility {(Hide,
Show).

Custom List: Allows a custom Quick List to be
configured for each resource.

Menn Jtems: Allows the items in the Edit, View,
Features, Phone, page and Folders menu items to
be to be customized.

Page List: Allows the creation of a custom list of
pre-programmed pages.

Speed Dial: Allows the creation of a custom
phone book for phones and allows entry of
custom speed dial aliases for the configuration.

Baslcs
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Folders Menu

Use the Folders menu to change configuration files in the following

ways:

e Add folders.
¢ Remove folders.

¢ Change the width of the folder tabs.

Selection Description

Add Folder Creates a new folder and adds it to the
configuration file.

Delete folder Deletes an empty folder from the
configuration file,

Customize Folders Changes the names and order of
folders, patch groups, and multiselect
groups.

Folder Tab Width Changes the width of the folder tabs as

they appear across the top of the
desktop.
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Help Menu

The Help menu provides the operator with access to on-line help while
working with Admin.

Selection Description

Contents Provides On-Line Help.

Using Help Provides instructions on how to use Windows on-
line help.

About Displays copyright information and software

CENTRACOM  version number for CENTRACOM Gold Series

Elite Elite Admin.
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Toolbar

One or two toolbars can be configured to provide quick access to often-
used features of Dispatch. Toolbar items can be arranged in any order.
This overview describes all available toolbar items.

lcon Item Description

Activity Log Shows or hides an Activity Log.
Show/Hide

All Mute Silences all unselected audio for a
preprogrammed time period, or until All
Mute is removed. The default time period
is 30 seconds and can be changed using the
Console Database Manager software
application. When the muting time is
complete, the unselected audio returns to
its previous level.

Alert Used to transmit specified alert tones to the
selected resource. (g

——”

Auxiliary I/O Shows or hides an Auxiliary YO Window.
Window
Show/Hide

Base Intercom  Allows a voice message to be heard by
maintenance personnel at a base station or
by an operator at a remote desktop console.

Channel Channel Marker allows a console operator
Marker to send a tone burst on all currently
selected conventional resources.

Delete Single Deletes the most recently selected stack
Stack Entry entry.

Delete Entire Deletes the entire contents of the stack with .-
Stack the most recently selected entry.
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Description

End Audible
Alarm

End
Emergency
Tones

General

Transmit

Intercom Call

Momentary
Override

Silences the audible alarm indicating an
event has occurred requiring immediate
attention. Choosing End Audible Alarm
silences the audible tone only and does not
affect the event that triggered the alarm.

Used to discontinue all emergency tones
being generated at the console position but
does not change the state of the emergency
that triggered the alarm.

Equivalent to pressing the Transmit switch
on the console or pressing the right
footswitch. Selecting General Transmit
initiates a transmission on all currently
selected resources.

Engages operator-to-operator(s) andio
communication. The intercom dialog
window appearing after clicking this button
is used to perform Selective intercom call
or All call intercom functions. All Call
allows a console position to send a voice
message to all active console positions in
the zone that are not acoustically
crossmuted with the initiating console.
Also, both features cannot be used at the
same time.

Momentary Override allows temporaty
selection of a voice encryption key and
initiates a2 Push-To-Talk (PTT) function.
Invoking this causes the console position to
send the appropriate commands to that
resource in order to use the selected key
for encrypting voice traffic, and then
initiate a transmission in secure mode.

Basics
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Icon

em

Description

Monitor
Squelch

Enable /
Disable
Operator
Position

Page, Standard

Page, Abort

Page, Checklist

Page, Send

Page, Re-Send

Phone Hold

Put Phone on
Hook

Public Address

Disables the squelch on the currently
selected resources, allowing the operator to
hear all of the audio regardless of the
private line code. See General Transmit
for details on Frequency Select, Private
Line and Monitor Mode .

Opens a dialog box that will allow an
operator to enable or disable a particular

console position.

Brings up the standard page dialog box for
a standard page session. It does not start

the session yet.

Aborts a paging session.

Starts a Checkl ist paging session.

Sends page to a collection of page
resources created in a standard page or
checklist page session.

Send button changes to resend when one or
more pages fail to be sent. Pressing this
button resends the pages that failed to be
sent in the previous paging session.

Places a telephone call on the selected

phone on hold.

Puts selected telephone on-hook.

Used to transmit over a public address

system.

68PB1095E70 - G
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item Description

Real Time Brings up the console telephone keypad,
Dialing allowing the operator to make a call on the
selected phone.

Safety Switch  Allows activation of a safety protected
resource after a delayed period of seconds.
This feature is also available under the
Features menu.

System Status  Clicking on this indicator opens the System
Status dialog.

Baslcs
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Overview of the Auxiliary /O Group Window
An Auxiliary YO Group Window is always positioned on top of the Elite

o

When setting up an Auxiliary [/O Group Window, note the following:

Position on the screen: The position of the Auxiliary O Window when
the configuration file is saved in Elite Admin is the initial position of the
Auxiliary 1/O Window when the configuration file is loaded into Elite
Dispatch.

Title: The name appearing on the Auxiliary I/O Window title bar. This is
the name of the Auxiliary I/O Group. N

N
-
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Chapter 2 Configurations

In this section, the operator will learn how to:

o .

create a new configuration file.
open an existing configuration file.
save a configuration file.

Creating a New Configuration

The following can be defined for each configuration:

Whether or not a password is needed to open the configuration.
The number of folders in the configuration.

The number of multiselect and patch groups in the configuration.
The location of the MSel/Patch area on the screen.

‘Whether or not the dispatch operator is allowed to temporarily
change folder resource assignments.

Whether or not the dispatch operator is allowed to move a resource
within a folder.

‘Whether or not tones should be generated when a message is
received in regards to a radio status or message.

If the phone dialer will automatically open when the phone is taken
off hook.

Whether or not the Dispatch operator is allowed to modify the
primary resource group.
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To create a new configuration:

1.

3.

Choose New from the Configuration menu. Admin displays the

New Configuration dialog box. A new configuration can also be
created from the Admin startup screen.

Configuration Password: Type a password if operators are to enter ‘\_)
a password when the configuration is opened, which can be up to
14 characters long. Skip this field if a password is not required.

N

&

()

Number of: From the applicable drop-down lists select the number
of folders (up to six), multiselect groups (up to three), and patch /™™
groups (up to sixteen).

—_—
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4.

6.

7.

8.

Set the position using the arrow buttons for the MSel/Patch arca in
main window.

Define the height of the MSel/Patch arca using the up and down
ATTOWS.

Choose the following selections that are applicable to this
configuration.

s Select the Allow Dispatcher Assign/Deassign checkbox to
grant the operator the capability to temporarily change folder
resource assighments during Dispatch.

e Select the Allow Dispatch Resources to be Moveable
checkbox to grant the operator the capability to move the
resource within the folder. If the checkbox is left unselected,
then the Dispatch operator is not allowed to move the resource
within the folder. Resources can always be moved within a
folder while using Admin.

e  Select the Enable Tones on Status/Message checkbox to
generate tones on reception of radio statuses and radio
messages.

¢ Display Phone Dialer when Phone is Selected will be
selected by default. This selection will cause the Phone dialer
to display, in Dispatch, when the phone is selected and the
resource is in the on-hook state.

s  Check Allow Primary Resource Group Modification to
give Dispatch users the ability of modifying Primary Resource
Groups. New configurations default to having this checkbox
checked.

When finished setting up the new configuration, choose Close
from the Configuration menu,

Save the new configuration file by choosing Save or Save As..,
from the Configuration menu.

e Type the desired name for the configuration. The
configuration file's path name can be changed if desired.

¢ Refer to the section entitled "Folders and Resources Set Up”
for detailed instructions on setting up the items within a
configuration.

To review or alter the saved configuration, choose Current
Configuration from the Edit menu.

Configurations
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Opening an Existing Configuration

To open an existing configuration file, do one of the following:

¢ Choose one of the four most recently accessed configurations from
the Configuration menu.

e Choose Open from the Configuration menu, then choose the
configuration to open from the Open Corfiguration dialog box. If
necessary, use the scroll bar to the right of the file list to find the
desired confignration.

Saving the Configuration

The user can save the modified configuration under its original name, or it
can be saved with a new name to create a new configuration and leave the
original file unchanged.,

1. Te save changes to an existing configuration, choose Save from
the Configuration menu.
If the configuration has already been saved at least once, Admin
saves all changes made to that configuration.

2. To save the changes as a new configuration, choose Save As from
the Configuration menu.
Admin displays the Save As dialog box.

3. Type a name for the configuration. The default extension 1s .ELT
for Elite files. Using Save As preserves the original configuration
by saving all the changes as 2 new configuration.
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Chapter 3 Folders and
Resources Set up

This section describes how to assign resources to configurations, and how
to set up the options available for each resource. The section also
describes how to add, modify, and remove folders from configuration
files.

Note: If the master database is changed while Elite Admin is running,
Admin will need to be restarted in order to recognize the changes.

Note: Changes made by choosing "Resource Header, "Audio” or
"Features” on the Set Up Resources dialog are lost unless you
choose "View Resource” and then "Accept” before leaving the Set
Up Resources dialog . The change is also accepted if the resource
is currently placed on a folder, or if the resource is placed on a
Jolder before saving the configuration file.

In Admin, drop down lists are used to help the user set up folders and
resources. Drop down lists contain a list of items that the user can enter
as part of the configuration for the resource. The user can click on the
scroll arrow of the drop down [ist to display the contents of the list and
locate the desired item to appear in the text box. In many cases, the drop
down list may contain a very long list of items and it is easier to locate the
item with an alphabetical search.

The List box Multi-Letter Search feature can be used thronghout the set
up process to alphabetically locate items within the drop down list.

Complete the following steps to use the List box Multi-Letter Search
feature to locate a desired item within a drop down list.

1. Click on the text box of the drop down list. The text box will
highlight.

2 Type the first few characters of the desired item. The first item that
matches the entered characters will display in the text box.

3. The item will also highlight in the drop down list and the drop
down list scrolls to the updated alphabetical position. If the item
displayed in the text box is not the desired item, it is now easier to
locate the item within the list using the scroll arrow.
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Setting Up Folders

Resources can be added to, or deleted from, existing folders or temporary
folders that the user has created.

1.

3.

S.

Ldit Folder Re:

To assign resources to a folder, choose Folders from the Edit

menu. m
The Edit Folder Resources dialog box is displayed, with the .y
currently selected folder displayed in the Folder drop-down list.

Choose the appropriate folder from the Folder drop-down list

Select the type of resources to be assigned from the Resource List
Type drop-down list. The available resource choices are Aux, Aux
Groups, Phone, Page, Radio, or AlL

Choose a resource to be assigned to the folder from the {ist on the
left.

To choose how the resource is displayed initially upon opening the
configuration, click on the Compressed or Expanded checkbox as
appropriate.

32
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6.

7.

10.

11

12,

13.

14.
15.

Use the Select or Unselect drop-down lists to specify the speaker
destination of a talk resource. If the chosen resource is not a talk
resource, then the Audio area of the dialog box is disabled.

Use the Volume drop-down list to set the defaunlt volume.

Use the Ring Tone drop-down list to specify the sound used when
a phone resource receives an inbound call.

Click on the right arrow button to assign the resource to the
folder.

Note: If this resource already exists in another folder and the user
has specified different audio settings, a dialog box
containing the following message appears:

This resource is already in use,
proceeding will change the current audio
settings. Continue?

Click OK to continue. The resource now appears on the right and
has been removed from the list on the left, which shows the
remaining available resources.

Click Cancel to end the procedure.

To remove a resource from the folder, choose the resource from
the list on the right.

Click on the left arrow button.

Note: If this folder is the only one containing this resource, a
dialog box containing the following message appears:

This 1s the last View of this Resocurce. Do
you want to remove it?

Click Yes to continue and return the resource to the list on the left.
e Click No to end the procedure.
Repeat steps 3 through 13 to edit more resources in the folder.

Click Close when finished editing resources. The Edit Folder
Resources dialog box closes, and the screen reflects the changes
made.
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Setting Up Talk Resources

Resource characteristics may be defined even if they are not placedon a
folder. Characteristics that can be changed are:

& The resource header. )

+ The features available for the resource.
¢ The speaker assignment for the select and unselect audio.

Resource Header Initial Default Settings

¢  Upon opening the Resource Header Dialog box for a Resource that
was not previously configured, the default Resource Classification is
Non-Primary.

» A Resource previously configured defaults to that setting.

s A Resource from an old configuration file that does not have the
Primary Resource capability will have a default setting of Non-

Primary.
Viewing Resource Settings
The current settings for a resource can be viewed before making changes,
1 Choose Resources from the Edit menu. ﬁ
e The "Set Up Resources” dialog box is displayed. —

2 Choose the desired type of resource from the Resource Selector
drop-down list called Type. The available choices are All, Aux,
Page, Phone, and Radio.

3. To view the resource’s Compressed and Expanded current
appearance click the View Resource button.

4, Clicking Accept, Cancel or the window close box returns the user
to the Set Up Resources dialog box.

5. Click Cancel to return to the Set Up Resources dialog box. None
of the checkmarks are green indicating that the resource settings
have not been accepted.

6. Repeat steps 3 through 5 to view the remaining resources.
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Chapter 3 Folders and

I'\:esources Set up

This section describes how to assign resources to configurations, and
how to set up the options available for each resource. The section also
describes how to add, modify, and remove folders from configuration
files.

Note: [If the master database is changed while Elite Admin is running,
Admin will need to be restarted in order to recognize the changes.

Note: Changes made by choosing "Resource Header, "Audio” or
“Features” on the Set Up Resources dialog are lost unless you
choose "View Resource” and then "Accept” before leaving the Set
Up Resources dialog . The change is also accepted if the resource
is currently placed on a folder, or if the resource is placed on a

folder before saving the configuration file.

In Admin, drop down lists are used to help the user set up folders and
resources. Drop down lists contain a list of items that the user can enter
as part of the configuration for the resource. The user can click on the
scroll arrow of the drop down list to display the contents of the list and
locate the desired 1tem to appear in the text box. In many cases, the drop
down list may contain a very long list of items and 1t is easier to locate
the item with an alphabetical search,

The List box Multi-Letter Search feature can be used throughout the set
up process to alphabetically locate items within the drop down list.

Complete the following steps to use the List box Multi-Letter Search
feature to locate a desired item within a drop down list.

1. Click on the text box of the drop down list. The text box will
highlight.

2. Type the first few characters of the desired item. The first item that
matches the entered characters will display in the text box.

3. The item will also highlight in the drop down list and the drop
down list scroils to the updated alphabetical position. If the item
displayed in the text box is not the desired item, it is now easier to
locate the item within the list using the scroll arrow.
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Setting Up Folders

Resources can be added to, or deleted from, existing folders or temporary
folders that the user has created.

™

1. To assign resources to a folder, choose Folders from the Edit
menu.

» The Edit Folder Resources dialog box is displayed, with the
currently selected folder displayed in the Folder drop-down
list.

2. Choose the appropriate folder from the Folder drop-down list

3. Select the type of resources to be assigned from the Resource List
Type drop-down list. The available resource choices are Aux, Aux
Groups, Phone, Page, Rado, or All.

4. Choose a resource to be assigned to the folder from the list on the
left.

5. To choose how the resource is displayed initially upon opening the
configuration, click on the Compressed or Expanded checkbox as

appropriate.

6. Use the Select or Unselect drop-down lists to specify the speaker m
destination of a talk resource. If the chosen resource is not a talk L
resource, then the Audio area of the dialog box is disabled.

7. Use the Volume drop-down list to set the default volume.
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Defining the Resource Header

The user has the ability to have three lines of resource information
displayed in the Header of a talk resource. The first line of information is
reserved for the resource name and cannot be changed. The second and
third lines of the Header may be defined by the user to contain either
feature status information or text. The user also has the ability to define
the border color of the resource header.

Complete the following steps to edit the Resource Header information.

1. Choose the Resource Header checkbox from the Set Up Resource
dialog box.

2, The Resource Header dialog box displays and contains the
resource name in the title of the dialog box. A preview of the
resource as it will appear on the dispatch screen is shown in the
preview section of the dialog box. Line 1 of the Resource Header
contains the name of the resource. This line cannot be edited.

3. To display a feature status on Line 2 or Line 3, choose the Feature
button from either line.
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The Text box becomes disabled.,

Select a feature status selection from the Feature edit box drop
down list. Any function that the resource is capable of performing
is shown in the drop down list.

s If the resource is a signaling resource, then the default
selection for Line 2 is “Unit ID/Alias” and the default
selection for Line 3 is “Status/Message”.

e  [If the resource is a non-signaling resource, then the default
selections for both Line 2 and Line 3 is *Blank (none)”.

s  If the resource header has been previously configured, then the
previous configuration settings are the default selections for
Lines 2 and 3.

¢ If the resource is an Auxiliary I/O or a Page resource, then
Lines 2 and 3 are disabled.

To display text in Line 2 or Line 3, sclect the Text button from
either line,

¢  The Feature edit box becomes disabled.
Click on the Text box and enter text, if desired.

Choose a Border color for the resource by choosing a color button
from the Border color area of the window.

Click OK to implement the changes.

e  Click Cancel to exit this dialog box without saving the
changes and return to the Set Up Resources dialog box.

* Note that the Resource Header checkmark is now green
indicating that the resource appearance has been defined.
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9.

10.

11.

12.

13
14.

Use the Ring Tone drop-down list to specify the sound used when
a phone resource receives an inbound call,

The default setting for all radio resources, in an old or new .clt
configuration file, is to have their Emergency Tone generating
ability enabled. From within Elite Admin (not Dispatch), users
can enable or disable the Emergency Tone (shortcut key Alt +m),
for a radio resource by highlighting the resource m the list then
clicking the Enable Emergency Tone checkbox. A checkmark in
the box enables the alarm. If a non-radio resource is selected, the
checkbox becomes unchecked and disabled (grayed out). If the
dialog is closed without adding the resource to a folder, the
resource will not change from its previous setting,.

Click on the right arrow button to assign the resource to the
folder.

Note: If this resource already exists in another folder and the user
has specified different audio settings, a dialog box
containing the following message appears:

This rescuxrce is already in use, proceeding
will change the current audic settings.
Continue®

¢ Click OK to continue. The resource now appears on the right
and has been removed frotn the list on the left, which shows
the remaining available resources. Click Cancel to end the
procedure.

To remove a resource from the folder, choose the resource from

the list on the right.

Click on the left arrow button.

Note: [f this folder is the only one containing this resource, a
dialog box containing the following message appears:

This is the last View of this Resource. Do
you want to remove it?

e Click Yes to continue and return the resource to the list on the
left. Click No to end the procedure.

Repeal steps 3 through 12 to edit more resources in the folder.

Click Close when finished editing resources.
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Setting Up Talk Resources

Resource characteristics may be defined even if they are not placed on a
folder. Characteristics that can be changed are:

& The resource header.
e« The features available for the resource.
e  The speaker assignment for the select and unselect audio.

Resource Header Initial Default Settings

e  Upon opening the Resource Header Dialog box for a Resource that
was not previously configured, the default Resource Classification is
Non-Primary.

A Resource previously configured defaults to that setting.

A Resource from an old configuration file that does not have the
Primary Resource capability will have a default setting of Non-
Primary.

Viewing Resource Settings

The current settings for a resource can be viewed before making changes.

1. Choose Resources from the Edit menu.
o  The "Set Up Resources" dialog box is displayed.

2, Choose the desired type of resource from the Resource Selector
drop-down list calied Type. The available choices are All, Aux,
Page, Phone, and Radio.

i To view the resource’s Compressed and Expanded current
appearance click the Yiew Resource button.

4. Clicking Accept, Cancel or the window close box returns the user
to the Set Up Resources dialog box.

S. Click Cancel to return to the Set Up Resources dialog box. None
of the checkmarks are green indicating that the resource settings
have not been accepted.

6. Repeat steps 3 through 5 to view the remaining resources,
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Statalert?
Unit ID1Alias
StatusiMessa
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Defining the Feature Display

This dialog box allows the user to define the features that appear on the
compressed and expanded views of each resource, and in what order the

features appear on the resource.
N

Note: Some features shown in the dialog box below may not be available
at this dispatch center.

Changing Resource Feature Appearance
To change the way the resource’s features appear onscreen:

1. Choose the Features button from the Set Up Resources dialog
box. The Set Up Features dialog box is displayed.

Note: If the resource is an Auxiliary VO, refer to the section
entitled, “Setting Up Auxiliary I/O Resources” for further
instructions. If the resource is a Page, refer to the section
entitled, “Setting Up Page Resources” for further
instruction.

Select the View to be edited by clicking on the appropriate ﬁ
tab; —
Compressed View
Expanded View, or
Preferred View

2. Edit the required view (see the following pages for details).

3. Click OK to accept the editing changes, and close the Set Up

Features dialog box.

Note: If the resource size overlaps another resource in a folder, a
warning message appears and the changes do not take
effect until sufficient room exists or resource feature buttons
are removed or stack size reduced.

3-8
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Set Up Featur

. ASTRO DIGITAL
Unir IDH A .
StatusiM:
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Editing the Compressed & Expanded View of a Resource

The compressed view of the resource can be edited from the Compressed

View folder tab as follows:

1.

3.

The number of Rows displayed in the Stack can be configured by
selecting the desired number from the drop-down list. For more
stack configuration details, sec Configure the Stack in this section

of the manual.

The ordering of the feature on the resource can be changed by
selecting the feature in the Button Ordering list-box and then
clicking on the ap or down arrow button to change its layout

position.

Check the Feature checkbox labeled Instant Transmit, Enable if the
instant transmit button is desired on the resource. If the operator is
to actuate the safety switch before doing an instant transmit, check
the Imstant Transmit, Safety checkbox.

The size of the uncompressed region (i.e. the view of the resowrce
that is always visible) can be increased or decreased using the
Expanded Region, Size plus and minus buttons. For example, the
Compressed View window (on previous page) shows 2 view of the
compressed resource after the pius button has been chicked twice to

increase.
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Editing the Expanded View

The expanded view of the resource can be edited from the Expanded
YView folder tab.

This folder is edited in the same manner as the Compressed View folder,
except that the Expanded View folder does not include the Expanded
Region, Size plus and minus buttons.

ESet Up Features

Mute Second Recener

Repeater Control
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Editing Bitmap & Microhelp

The bitmap and microhelp for some features can be edited from the
Compressed View or Expanded View folder tab by clicking on their

button in the resource View window. When the button of a feature that f-\
has this capability is clicked, a dialog box similar to the following will ~ “~—
display:

£ aline Wide/local Area Bkmaps
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From this dialog box, the bitmap and microhelp to display for each of the
feature supported states can be selected.

1. Use the scroll boxes to highlight the bitmap to be used for each of
the button’s states. The button’s appearance is previewed at the
top of each box.

2, The microhelp associated with each of the states of the button can
be changed by entering the desired text in the Micro Help Text
boxes.

3. Click OK to accept the changes or Cancel to discard them.

4. Repeat steps 1 through 3 to alter the appearance of other editable
- buttons.

Note: Some buttons have fewer than three valid states. In these
cases, the corresponding scroll bars and microhelp text
boxes are disabled. Also, in some cases, the bitmaps and
microhelp for certain states will depend on those selected
for other states. The preview buttons are automatically
updated to reflect this.
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Sort Order of a Drop-down list

The sort order of a drop-down list can be altered from the Compressed
View or Expanded View folder tab.
-

If a sortable resource is clicked on, the following dialog box appears:

Defirie Ftequenc: Select _SoridEI
e

A
1. Choose the desired sort type.
2, Click OK to accept the changes or Cancel to discard them,
3. Repeat steps 1 and 2 to alter the sort order of other drop-down
lists.
'
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Default and Preferred Resource View

The default resource view can be selected from the Preferred View
folder tab.

et Up Features

ASTRODIG 1 | = T ASTRO DIG 1

The preferred view of a resource can be 2 Compressed view or an
Expanded view of the feature.

Note: Changing the Preferred View will not change the view of
resources already placed on a folder. To change resources that
have already been placed, remove the resource from the folder

then re-add it.
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Configure the Stack (Window)

Right Column Display Mode

The left column of the stack will always display the ID or Alias of the ‘\. )
incoming subscriber. )

The second or "right"” column can be configured with various features and
functions; any configurations made to the Stack Configuration will be
visible in compressed or expanded view.,

Two display modes available are Status and Time that a call is received
for a resource. A third mode such as that for ASTRO CAI resources is
the Secure Key option, but this is only shown in the list if the resource
has been configured with the "Inbound Secure Key” capability from
within the Console Database Manager (CDM).

‘While working in this menu, to move a selection to another position in the
list and the order in which it will appear in the stack second (or "right")
column, use the Up or Down arrows. Whichever item is positioned at
the top of the list becomes the default display mode in Dispatch.

To configure the stack, open the Configure Stack dialog by clickingon  (*
the stack area of the Set Up Resources dialog, and complete the following ~—
steps:
L Select the modes that can display in the right colummn of the stack.

At least one selection must be chosen.

2. To arrange the order that the modes will display, when toggled in
Dispatch, use the Up and Down Move arrows.

3. Click OK to complete the selection or click Cancel to return to the
Set Up Features dialog without configuring the stack.
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Configure Stack
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Double-Click Feature

Each mode selected (checked) in the list can be assigned one left mouse

button "double-click™ function, but only if the function is part of the
resources assigned dispatch capabilities from within the CDM (sec the
following table). Functions set for double-click capability will appear
bold in the right-mouse pop-up menu.

Action Resource Capabilities (in CDM)

| (None) n/a

| Acknowledge Emergency Alarm | Emg Recog
Send Call Alert Call Alert Out
Send Private Call Private Call
Send Radio Check Radio Check
Send Radio Disable Radio Disable
Send Radio Enable Radio Disable
Send Remote Monitor Remote Monitor

|_Send Status Request Status Request
Send Voice Selective Call Ve SelCall Out

Doubfe-click Function Assignments

™

-

Note: For an existing configuration created with an old version of
Admin without the Double-Click functionality, the Double-Click
Action will be set to “(None)” for each resource when the
configuration file is viewed using the newer version of Admin.

o

Note: If the dispatch capability of a previously set Double-Click Action
has been removed in the CDM and the Stack Configuration Dialog
is brought up a warning message will display informing the user
the capability no longer exists. The Double-Click Action for the
resource will be set to “(None)”.

CENERACOM Elte
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If the user attempts to remove a chicklet associated with a currently saved
Double-Click Action in the Set Up Feature dialog , a message box will be
displayed to inform the user that the Double-Click Action must be
changed before the chickiets can be removed.

To remove a chicklet associated with a currently saved Double-Click
Action property the user will have to change the Double-Click Action to
some other action or “(None)”. This requirement applies to both the
compressed and expanded tile views.
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Defining the Three Line Display

The user has the ability to have three lines of resource information

displayed on a talk resource. The user may define the lines to contain

either feature status information or text. The Three Line Display is similar (™ )
to the Resource Header feature. The difference is that the Three Line v
Display can be configured and moved about the resource just like any

other feature control while the Resource Header line display is anchored

within the Header.

Complete the following steps to edit the Three Line Display information,
1. Select the Features button from the Set Up Resources dialog box.
¢ The Set Up Features dialog box will display.

2. Select the View to be edited by clicking on the appropriate tab:
Compressed View or Expanded View.
3. Select the Three Line Display checkbox from the Button

Ordering area of the dialog box. By defanlt the Three Line
Display selection will be unchecked.

e The View area of the dialog box displays a preview of how the
resource will appear on the dispatch screen. ™

b
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ESet Up Features
St

{| Blank [none)
| Blank [nanej
Blank [none)

Click here to
display the Three
Line Display
dialog box.

4, Click on the resources Three Line Display region in the View area.
e The Three Line Display Configuration dialog box will display
and contain the resource name in the title of the dialog box.

5. To display a feature status in Line 1, Line 2 or Line 3. select the
Feature button from any line.

e The Text box becomes disabled.
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This is a Three
= Line Display

, alias

'

p—

Select a feature status selection from the Feature edit box drop
down list. Any function that the resource is capable of performing
is shown in the drop down list.

s  The default selection for each line is “Blank (none)”.

To display text in Line 1, Line 2 or Line 3, select the Text button

from any line.

e  The Feature edit box becomes disabled.

Click on the Text box and enter the desired text.

Click OK to save the changes, The changes are displayed in the

resources Three Line Display region of the View area.

e  Click Cancel to exit this dialog box without saving the
changes, The previous Three Line Display configuration is left
intact.

~

e
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Defining the Audio Destination

Complete the following steps to define the audio destination and the
initial volume level of a selected talk resource. The operator can change
the volume level, but it reverts to the level set in Admin when the
operator exits Dispatch.

1.

2.

Choose Resources from the Edit menu.
¢ The Set Up Resources dialog box is displayed.

Choose the type of resources to view from the Resource Selector
drop-down list.

e The available resource choices are All, Aux, Page, Phone, and
Radio.

Choose the resource to be defined. Then choose the Aundio button
to define the resource’s andio destination.

e The Set Up Audio dialog box is displayed.

Note: The Audio button is enabled only for Radio and Phone
resources.
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4.

6.

7.

Choose the speaker destination for the resource’s select and
unselect audio from the drop-down lists.

Note: The number of monitor speakers shown in the list is
determined by the maximum number of speakers available
at any one console position in the dispatch center.

Choose the initial volume from the Initial Volume drop-down [ist.
The choices are 1 (softest) through 7 (loudest).

If the resource is a phone, then a box for selecting the ring tone is
enabled. Choose the desired ring tone.

Click OK to save the changes. The screen returns to the Set Up
Resources dialog box. Note that the Audio checkmark is now
green.

Click Cancel 1o exit this dialog box without saving the
changes and return to the Set Up Resources dialog box.

Click Close to exit the Set Up Resources dialog box.
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Setting Up Auxiliary O Resources

Augxiliary I/Os (auxiliary inputs/outputs) are external devices such as fire
alarms, burglar alarms, and door locks that can be monitored and/or
u controlled by the operator. Admin can define the appearance of the
Auxiliary I/O in Dispatch and configure an Auxiliary I/O so a safety
switch must be actuated before the Auxiliary I/O status can be changed.
Admin can also configure an Auxiliary I/O to cause an audible alarm.

Defining Auxiliary I/O characteristics.
1. Choose Resources from the Edit menu.
" & The Set Up Resources dialog box is displayed.
2. Choose Aux from the Resource Selector drop-down list.
*  All Auxiliary I/Os are displayed in the list.
3. Choose the Auxiliary I/O to be defined from the list.
4. To set resource border color, choose the Resource Header button.

e The Resource Header Configuration dialog box displays with
the resource name in the title.

5. To change the border color select the checkbox of the desired color.

U 6. Click OK to accept the Auxiliary I/O border color and return to the
Set Up Resources dialog box.

» Click Cancel to close this dialog box without saving the
change and return to the Set Up Resources dialog box.

7. Click the Features button from the Set Up Resources dialog box.
¢ The Define Aux I/O Features dialog box appears.

8. To require the operator to actuate the safety switch before
changing the status of the Auxiliary /O, check the Safety Protected
checkbox.

9. To have the Auxiliary I/O sound an audible alarm, check the
Audible Alarm checkbox.

10. Define Auxiliary I/O appearance on screen by choosing from the State
1 and State 2 lists. Choose the State 1 and State 2 bitinaps to best suit
the type of Auxiliary /Os the Dispatch console is monitoring, and
u what condition is represented by the Auxiliary I/O.
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11.

12,

Note: For Auxiliary inputs State 1 is where the input is open
circuited and State 2 is where the input is closed circuited
(shorted).

Click OK to accept the Auxiliary I/O display and return to
the Set Up Resources dialog box.

¢ Click Cancel to close this dialog box without saving the
change and return to the Set Up Resources dialog box.

Repeat the procedure as required to define the appearance of
all Auxiliary I/Os included in the configuration.

S

®
M
A
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Defining the Audio Destination

Complete the following steps to define the audio destination and the
initial volume level of a selected talk resource. The operator can change

U the volume level, but it reverts to the level set in Admin when the
operator exits Dispatch.

1.

2.

4.

Choose Resounrces from the Edit mepu.
s  The Set Up Resources dialog box is displayed.

Choose the type of resources to view from the Resource Selector
drop-down list.

¢ The available resource choices are All, Aux, Page, Phone, and
Radio.

Choose the resource to be defined. Then choose the Audio button
to define the resource’s audio destination.

s The Set Up Audio dialog box is displayed.

Note: The Audio bution is enabled only for Radio and Phone
resources.

Sleq

ik Ungel'c‘

Choose the speaker destination for the resource’s select and
unselect audio from the drop-down lists.

Note: The number of monitor speakers shown in the list is
determined by the maximum number of speakers available
at any one console position in the dispatch center.

Choose the initial volume from the Initial Volume drop-down list.
The cheices are 1 (softest) through 7 (loudest).
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6. The default setting for all radio resources in an old or new .elt
configuration file, is to have their Emergency Tone generating
ability enabled. From within Elite Admin (not Dispatch), a user
can enable or disable the Emergency Tone for a radio resource by
clicking the Enable Emergency Tone checkbox as shown above. m
A check in the box (shortcut Alt + m) enables the alarm for that
resource to be heard at the Console. If a non-radio resource is
selected, the checkbox is made invisible in the Set Up Audio
dialog.

—

7. If the chosen resource is a phone, then a box for selecting the ring
tone is displayed and enabled as shown below. Choose the desmred
ring tone.

‘jet Up Audio .

one 1

8. Click OK to save the changes. The screen returns to the Set Up
Resources dialog box. Note that the Audio checkmark is now
green.

s  Click Cancel to exit this dialog box without saving the
changes and return to the Set Up Resources dialog box. Click
Close 1o exit the Set Up Resources dialog box.
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Setting Up Page Resources

The paging feature is used for sending pages to individuals or groups.
Admin can be used to define the appearance of a Page in Dispatch.
Admin can also be used to configure a Page so that a safety switch must
be actuated before the Page can begin.

The procedure for defining Page Characteristics is provided below.

L

3.
4.

s.

6.

7.

10.

Choose Resources from the Edit menu.

+ The Set Up Resources dialog box is displayed.
Choose Page from the Resource Selector drop-down list.
e  All Pages are displayed in the list,

Choose the Page to be defined from the list.

To set the resources border color, choose the Resource Header
button.

s The Resource Header Configuration dialog box displays with
the resource name in the title.

To change the border color, select the appropriate checkbox of the
desired color.

Click OK to accept the Page border color and return to the Set Up
Resources dialog box.

s Click Cancel to close this dialog box without saving the
change and return to the Set Up Resources dialog box.

Click the Features button from the Set Up Resources dialog box.
»  The Define Page Features dialog box appears.

To require the operator to actuate the safety switch before
changing the stats of the Page, check the Safety Protected
checkbox.

Define the Page's appearance on screen by choosing from the Idle
list.

Click OK to accept the Page display and return to the Set Up
Resources dialog box.

¢ Click Cancel to close this dialog box without saving the
change and return to the Set Up Resources dialog box.

Folders and Resources Set Up 68FP81095E70 - G 327



11. Repeat the procedure as required to define the appearance of all
Pages included in the configuration.

Define Page Features

9.
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Defining the Default Resource

The CENTRACOM Gold Series™ Admin application allows, through the
use of Default Resources, a mechanism to define a default presentation
for resources. These default attributes are imposed on any resource when
it is assigned in Elite Dispatch if the resource was not configured or
placed on a folder in Elite Admin. Note: The default attributes are not
imposed on any resources in Elite Admin.

There are four Default Resources available for configuration: Default
Aux., Default Radio, Default Pager, and Default Phone.

To configure one of the Default Resources, follow the procedure
described in the section titled “Setting Up Resources™. Select the desired
type of default resource (Default Aux., Default Radio, Default Pager or
Default Phone) to configure from the list provided in the Set Up
Resources window.

Note: In the Set Up Features window, the Default Resources displays the
sum of all features in the master database. However, only some of
the features are available on the actual resource when assigned in
the CENTRACOM Gold Series™ Elite application.

Note: When the configuration (for default settings) has been selected, the
configuration for that resource must be viewed and accepted. This
saves the settings as the default configuration and a check mark
appears beside the default resource. If this step is omitted, changes
made to the default configuration are not saved.
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Chapter 4 Customizing Folders

Folders in a configuration may be customized. New folders can be named
and the names of existing folders can be edited.

Change Desktop Order

The desktop order (left to right) of the folders may be changed.

I. Choose Customize Folders from the Folders menu.
e  The Customize Folders dialog box is displayed.

2. To change a folder’s name, click on the Folder Names tab.
s  The currently used folder names appear.

3. Select the current name of the folder to be edited.

4. Type in a new name for the folder.

5.  Click OK to accept the changes and close the dialog box.

s Click Cancel to close the dialog box without applying the
changes.

¢ Click Apply to accept the changes and continue to customize
folders.

6. Choose the MSel Names tab to change the name of a multiselect
group.
»  The currently used multiselect group name appears.

7. Select the current name to be edited.

8. Type in new name for the multiselect group.
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9, Click OK to accept the changes and close the dialog box. ™\

¢ Click Cancel to close the dialog box without applying the -
changes.

s Click Apply to accept the changes and continue to customize
folders.

10. Choose Patch Names to change the name of a patch group.
¢  The currently used patch name appears.

11.  Select the current name to be edited.

12. Type in a new name for the patch group.

13. Click OK to accept the changes and close the dialog box.

s  Click Cancel to close the dialog box without applying the
changes.

e Click Apply to accept the changes and continue to customize
folders.

14. Choose Reorder to change the order in which the folders appear
on the screen.
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e A list of the configuration’s folders, in the current order,
appears. The folder at the top of the list will appear furthest to
the left when the configuration is opened.

15. Choose the folder to reorder. Then, use the up or down arrow to
change the folder’s order in the list.

16. Click OK io accept the changes and close the dialog box.
# Click Cancel to close the dialog box without applying the

changes.
s  Click Apply to accept the changes and continue to customize
folders.
Adding a Folder

Complete the following steps to add a new folder to a configuration:

i. Choose Add Folders from the Folders menu.

e  Anempty folder with the default name of “Folder (n)” is
added to the configuration.

2. To name the new folder, follow the steps outlined in the section
titled “Customizing Folders™.

Empty and Delete a Folder
To delete a folder from a configuration, the folder must first be empty.

To empty the folder:

1. Choose the folder to be removed from the configuration by
clicking on its folder tab.

2. To remove resources from the folder, choose Folders from the
Edit menu.

e The Edit Folders dialog box appears, with the currently
selected folder shown in the Folder drop-down list.

3. Choose a resource from the Resources Assigned to Folder list on
the right.
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4. Choose the left arrow to remove the resource from the folder.

¢ The resource now appears on the left and has been removed
from the list on the right, which shows the remaining resources

on the folder.
5. Repeat the previous two steps to remove the rest of the resources )
from the folder. -
6. When all resources have been removed from the folder, choose
Close.

¢ The dialog box closes. The folder can now be deleted.

To delete the folder:

1. With the empty folder selected, choose Delete Folder from the
Folders menu.

¢  The folder is removed from the configuration.

Changing the Folders Tab Width

The width of the folders tab can be resized to a setting of Large. Medium m
or Small. The default sctting for a Large folder tab width is 800 x 600 ad
and allows 6 folders to be placed in the work area. For a Medium folder

tab width is 2/3 of the defanlt Large folder tab. The Small folder tab

width is 1/2 of the defaunlt Large folder tab.

The default value tab widths for the Large, Medium and Small folders
can be overridden by setting the regisiry vatues LargeFolderTabSize,
MediumFolderTabSize and SmallFolderTabSize. Please see the registry
section for more details.

The folders tab label is truncated if the folders tab are resized such that
they are smaller than their labels.

To change the folder tab width:
1. Choose Folder Tab Width from the Folders menu,

s  The Folder Tab Width dialog box appears, indicating the
current folder size. [

2.  Set the folder tab width by selecting one of the three option )
buttons for the folder tab width setting; Large, Medium or Small.

44
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3.

older Tab Wwhdth

Click OK to resize the folders tab and close the dialog box.

e Click Cancel to close the dialog box without applying the
change in size.

e Click Apply to accept the change in size without closing the
dialog box.
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External Rescurce Assignments

An Extemal Resource Assignment is an assignment which is not initiated

by the console operator either explicitly or through an .elt file. Externally
assigned resources are placed on the “External Assignment Folder”.

Once placed on a folder, an externally assigned resource (such as one ~.-7
initiated by a CAD application) can be used as any other resource

available to the Elite Application operator.

Enabling External Assignments

To enable the Elite application to receive external assignments, the
registry valuc SharedResourceControl must be added and enabled. Please
see the registry section for more details.

Selecting the External Assignment Folder

Any existing folder can be chosen as the External Assignment Folder.

1. Choose Customize Folders from the Folders menu.

2. The Customize Folders dialog box displays.

i Select the Folders Name folder tab. N

Choose the folder to be used for External Assignments from the -
External Assignment Folder drop-down list.

s Click OK to accept the changes and close the dialog box.

*  Click Cancel to close the dialog box without applying the
changes.

s Click Apply to accept the changes and continue to customize
folders.
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ustnmize Fulders

Selecting an External Resource Assignment Folder
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Chapter 5 Resource Groups

Multiselect (MSEL) Group

Am operator can transmit to many different resources at once when those
resources are collected into an MSEL group. These resources include
trunking talkgroups, conventional channels and phone lines. Private calls
and multigroups may not be included in an MSEL group. Up to three
different MSEL groups per console can be configured.

Patch

A Patch is created to allow users of dissimilar resources (different
frequencies, different infrastructure) to communicate with each other.
Telephones and radio resources can be patched together. A patchisa
way of connecting resources so that when a call is received on one
resource the andio is passed along to another resource. Operators would
use it to allow radios on different systems to talk to each other directly.

Primary Resources

Primary Resources are radio resources designated by system
administrators and dispatchers for a higher handling priority and are
signified on resource headers with a "diamond” symbol.
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Resource Groups such as Primary, Patch and Multiselect can be
configured by the administrator and have settings defined when a new
configuration is created.

The following figure shows the Number of Folders, Msels and Patch
Groups from the New Configuration window. ')

The position of the Msel/Patch window in the Dispatch interface can be S
designated by the horizontal and vertical arrow buttons. Once the
configuration is saved, the Msel/Patch window will always appear in this
same position on the screen.

ENew Cunhgulmn ) i MJ
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The Dispatch Options portion of the window enables:

Resources on the screen to be Movable.

Resources to be Assigned or Deassigned.

Enable Tones on Status/Message.

Display Phone Dialer when a phone is selected by a user.
Allow Primary Resource Group Modification from within the
Dispatch application,

Settings can be changed later by accessing Current Configuration from
the Edit menu.

Editing Msel/Patch Configurations
Complete the following steps to change Msel/Patch settings.

|

2.

5.

Choose Current Configuration from the Edit menu. The Edit
Configuration window appears.

Set the number of multiselect groups (zero through three), and
patch groups (zero through sixteen) by choosing from the drop-
down lists.

Set the position of the MSel/Patch area on the desktop using the
left and right arrows.

Set the size of the MSel/Patch area using the up and down arrow
buttons.

Note: The MSel/Patch area can be moved only if the destination
area is empty on all folders. This is to prevent a resource
from being inadvertently hidden behind the Msel/Patch
area.

Click the Close button.
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Setting Up Resource Group Configurations

Radio resources to be included in resource groups can be specified for
every configuration. Then, when the configuration is opened in Dispatch
the groups automatically contain the radio resources assigned to them.

Edit Hesuure Groupt .

)

1. From the Edit menu choose Resource Groups.

¢  The Edit Resource Groups dialog box appears, listing
resources available for assigning to groups.

2, From the Groups drop-down list box, Primary Resources, Msel
and Patch can be selected.

3. Choose the Primary Resource, Patch or Multiselect group to be set
up or edited from the drop-down list at the top of the dialog box.

4. Choose Radio, Telephone, or All from the Type drop-down list to
see the resources in the Available list. Only resources assigned to
folders appear in the list.

Note: Phone resources must be added to patches by the operator
during Dispatch because a telephone has to be off-hook ('\
before it can be added to a patch group. -
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5.

6.

Note: Telephone resources cannot be placed in multiselect
groups. If a multiselect group is edited, then only radio
resources are available from the Resource Type list.

Note: A radio resource can be placed in only one patch group in
a configuration. A radio resource can be placed in multiple
multiselect groups.

Note: All assigned or unassigned radio resources that have NOT
been designated as Primary Resources will be shown in the
Available list box when a user selects Primary Resource
from the Groups drop-down list,

To add a resource to the selected group, choose it from the
Available list and click on the right arrow button to place the
resource in the Selected group.

Repeat steps 2 through 5 as required for each resource to be added
to the group.

To delete a resource from the group, choose it from the list on the
right. Then use the left arrow button to remove it from the group.

e The resource now appears in the list on the left and is
available for assignment to another group.

Repeat the previous step for all resources to be removed from the
group.

When all changes have been made, choose Close to exit the dialog
box.

Note: The administrator should be aware that Msel and Patch
Group are considered temporary by the system and tabs of
an idle patch start to flash after a predefined time; this can
be annoying to dispatchers. The dispatcher can set up and
remove groups as needed from Dispatch.
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Chapter 6 Setting Up
Auxiliary Input/Outputs

Auxiliary I/Os (auxiliary inputs/outputs); external devices such as fire
alarms, burglar alarms and door locks- can be monitored and possibly
controlled by the console operator. The Admin application can be used to
define the appearance of the Auxiliary I/O in Dispatch. Admin also can be
used to configure an Auxiliary I/O so that a safety switch must be
actuated before the status of the Auxiliary I/O can be changed. The
Auxiliary I/O can also be configured to initiate an audible alarm.

The procedure for defining Auxiliary /O characteristics is provided
below.
1. Choose Resources from the Edit menu.

s The Set Up Resources dialog box displays.

2 Choose Aux from the Resource Selector drop-down list.
All Auxiliary I/Os are displayed in the list.

3 Choose the Auxiliary I/O to be defined, from the list.
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5.

To set the resources border color, choose the Resource Header
button.

e  The Resource Header Configuration dialog box displays with
the resource name in the title.

To change the border color, select the appropriate checkbox of the /7
desired color. .

Click OK to accept the Auxiliary I/O border color and return to
the Set Up Resource dialog box or click Cancel to close this dialog
box without saving the change and return to the Set Up Resources
dialog box.

Choose the Features button from the Set Up Resources dialog box.
e  The Define Aux VO Features dialog box appears.

Define 'Au /0 Features

SERS
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8,

9,

10.

11,

12,

To require the operator to actuate the safety switch before
changing the state of the Auxiliary I/O, check the Safety Protected
checkbox.

To have the Auxiliary I/O to sound an audible alarm, check the
Audible Alarm checkbox.

Note: If Safety Protected and Audible Alarm are checked, their
associated tool bar buttons must be added manually. Refer
to ‘Configuring the Toolbar' section of this manual for
instructions.

Define the Auxiliary I/O’s appearance on screen by choosing from
the State 1 and State 2 lists. Choose from the State 1 and State 2
bitmaps to best suit the type of Auxiliary I/Os the Dispatch console
is monitoring, and what condition is represented by the Auxiliary
1/0.

Click OK to accept the Auxiliary /O display and return to the Set
Up Resources dialog box or click Cancel to close this dialog box
without saving the change and return to the Set Up Resources
dialog box.

Repeat the procedure as required to define the appearance of all
Auxiliary I/Os included in the configuration.
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Setting Up Auxiliary YO Groups

Auxiliary /O Groups contain Auxiliary I/0’s organized into functional
dispatch groupings.

-

Administrators can define as many Auxiliary /O Groups as desired. One ~ __
or more groups c¢an be placed on the Elite desktop but only one group can
be placed in the Auxiliary /O Window.

Editing Auxiliary 1/0 Groups
To set up Auxiliary O Groups:

1. Choose Auxiliary /O Groups... from the Edit menu. The
Auxiliary YO Group dialog box displays.

b

Au 1/O Group

The following options are available:
»  Create a new group by clicking on the Create Group button.
e Modify an existing and selected group by clicking on Medify

Group button,
s Delete an existing and selected group by clicking on Delete |
Group button.
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Create New Auxiliary 1/0 Groups

1.
2.
3.
4.

5.

Click on the Create Group button.
The Edit Auxiliary I/0 Group Create/Modify dialog box displays.
Assign a name to the Aux IO group in the Name edit box.

Select the number of columns for the group by selecting it from the
drop-down box labeled Maximum number of columns

Select the desired Aux I/O’s from the list box labeled Auxiliary /O
by clicking on the check box attached to each of them.

» The Aux /O tile is automatically placed in the group.

. & If desired, move the position of the Aux I/O tile by selecting

the tile in the list box and then using the Up/Down arrow
button to change its position within the list,

e  As thetile position within the list changes, its position within
the group is also changed.

Change the color of the interlock indicators by choosing a selection
from the Interlock Color combo box.

Aux I/O tiles can be removed from the group by deselecting them
in the list box.

Click OK to accept the Auxiliary I/O Group and return to the
Auxiliary I/O Group dialog box.

e Click Cancel to return to the Auxiliary I/O Group dialog box
without creating a new Auxiliary /O Group.
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Modify Auxiliary I/0 Groups

To modify Auxiliary I/0 Groups:

1. To modify an existing Aux I/O group, sclect the group name from
the list box and click on the Modify Group button. { "

2 If desired, change the Aux I/O assignments by following steps 2 to
8 of the “Creating a new Group” section.

Delete Auxiliary 1/0 Groups
To Delete Auxiliary /O Groups

1. Remove the Aux Group from Aux FO window if necessary.

2, To delete an Aux IO group, select the group name from the list
box and click on the Delete Group button.

3. Follow the steps outlined in the “Setting Up Folders” section to
remove an Auxiliary /0 Group from a folder.

Setting Up Auxiliary I/O Groups on the Elite Desktop ')
s

Follow the procedure in Chapter 3, “Folders and Resources Set Up”
under *Setting Up Auxiliary I/O Resources”
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Chapter 7 Configuring the Toolbar

The CENTRACOM Gold Series™ Elite application supports multiple
toolbars, toolbar button placements, toolbar button inclusion/exclusion
from the toolbar, and a clock display. Refer to the "Basics” section for
description of cach toolbar feature.

1.

To configure the toolbar choose Toolbar from the Edit menu; this
causes the Design Toolbar window to appear. The default
configuration for the toolbar is:

e Toolbar 1 selected for button assignment changes.

» Toolbar 1 included on console.

¢ Toolbar 2 not included on console.

¢ Showclock.

Select the Include Toolbar 1 on Console checkbox if this toolbar

is to be displayed on the Dispatch console.

Select the Include Toolbar 2 on Console checkbox if this toolbar

is to be displayed on the Dispatch console.

Select the Show Clock checkbox if the clock is to be displayed to

the right of the top toolbar (i.e., Toolbar 1}.

Tip:  Pue to the limit of screen area, the clock (next to

Toolbar 1) may be displayed off the right side of the screen.
To allow space for the time to be displayed, move toolbar
items from Toolbar 1 to Toolbar 2.

If changes are to be made to the buttons displayed on the toolbar,

select the desired toolbar button from the top of the Toolbar

Design window:

e select the Toolbar 1 option button, or

¢ select the Toolbar 2 option button.

Arrange the toolbar buttons on the toolbar:

e Select the toolbar button to be moved up/down in the provided
list.

e  Click the up arrow buiton to move the selected toolbar button
up the list. Click the down arrow button to move the selected
toolbar down the list. Up moves things to the left on the
toolbar and Down moves them to the right on the toolbar.

Configuring the Toolbar 68P81095E70—- G 7-1



6.

M Safety Switch

(J

Delete Stack Entry
Dalete Entire Stack
Activity Log

Auxiliary VO Window

Phone Release

Put Phone On Hold

Add/remove toolbar buttons from the toolbar by selecting the checkbox
next to each toolbar button that is to be displayed in the toolbar, or de-
selecting the checkbox for buttons that are not to be displayed.
Change the icon and tooltips (microhelp) used for the toolbar
buttons:
s  Select the toolbar button to be edited, and ensure that it has
been added to the toolbar as described above. The Edit button
becomes enabled,
¢ Click the Edit button. See the section titled "Defining the
Feature Display” for details of its operation.
Save the changes made to the toolbar by clicking the OK buiton,
The changes made to the toolbar are updated on the current screen.
e  Click Cancel to return to the Design Toolbar window without
saving the changes. ﬁ

—
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Chapter 8 Editing Preferences

The Preferences menu item provides access to a dialog box that allows

() the configuration of the Activity Log . Auxiliary YO Window, Custom
List (Radio}, Menu Ttems, Page List and Speed Dial.

Activity Log
To customize the view of the activity log:

1. Choose Preferences from the Edit menu to open the Preferences
dialog box.

2. Select the Activity Log tab.

Ficlérenens

3. If desired, select the Show Activity Log check box.

) e If checked, the activity log will initially be shown in Dispatch.
() e If not checked, the activity log will have to be opened in
Dispatch via View/Activity Log.

Editing Freferences 68P81095E70- G 8-1
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Note:

Note:

If desired, select the Allow Activity Log Modification in Dispatch
check box. If checked the activity log parameters can be modified n
Dispatch.

In Log to File (only available when nmning Windows® 2000 or lateh
checking the box enables saving all activity log data regardless of
selected content columns to a log file that has the extension .Jog . The
default naming configuration is [Current_elt Name].activity.log and
these files can be opened with Notepad or imported into Microsoft
Excel. The default saving location is C:\Documents and Settings\All
Users\Decuments\CENTRACOM\Activity Log. To change this
location, see the Registry Settings section (ActivityLogPath) of this
chapter.

The File Size limit choices range from 1 to 20 megabytes which can be
set using the scrollable box.

Windows Explorer may display the path differently between operating
system versions. For example, in Windows XP the Documents folder is
displayed as Shared Documents.

Unless the log file is backed up once the designated file size is reached,
data added to the log file will be lost. Also note a separator line is
added to the log file after each Dispatch session. This happens whe
Dispatch is started up or the dispatch user changes to another
configuration file then back to the current configuration file.

~ -

To configure the number of rows the Activity log window will
contain select the appropriate number from Total Rows.

To configure the type of information to display in each column,
and the number of columns the activity log will have, perform the
following steps:

o  From the Selected Contents screen area, select each item to be
displayed in the activity log.

¢ Determine the order the items will appear in the activity log
by highlighting the Selected item and using the Move
Arrows,

Note: During this operation, the View Activity Log area of the screen
will be active and will reflect the changes made in the selection
and ordering of the in the items in the activity log. o)

When you are satisfied with the setup of the activity log: -

» Click OK to accept the changes and close the dialog box.

&2
04/04/04
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Chapter 8 Editing Preferences

The Preferences menu item provides access to a dialog box that allows
the configuration of the Activity Log , Auxiliary /O Window, Custom
List (Radio), Menu Items, Page List and Speed Dial.

Activity Log
To customize the view of the activity log:

1. Choose Preferences from the Edit menu to open the preferences
dialog box.

2. Select the Activity Log tab.

Preferences

i e

a

Resource  Unit Stetus

s e S E
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Note:

7.

If desired, select the Show Activity Log check box.

» If checked, the activity log will initially be shown in
Dispatch. If not checked, the activity log will have to be
opened in Dispatch via View/Activity Log

If desired, select the ARow Activity Log Modification in

Dispatch check box.,

» Ifchecked the activity log parameters can be modified in
Dispatch.

In Log to File {only available when running Windows® 2000),
checking the box enables saving all activity log data, regardless of
selected content columns, to a log file that has the extension .Jog and
a default naming configuration of [Current_elt Name].activity.
.log files can be opened with Notepad or imported into Microsoft
Excel.

The default saving location is C:\Documents and Settings\All
Users\Application Data\CENTRACOM for the current .elt.

The File Size limit choices range from 1 to 20 megabytes which can
be set using the scrollable box.

Ifthe log file is not backed up once the designated file size limit is m
reached data thereafler will be lost.

Also note a separator line is added to the log file afier each

Dispatch session. This happens when Dispatch is started up or the
dispatch user changes to another configuration file then back to the
current configuration file.

To configure the number of rows the Activity log window will
contain select the appropriate number from Total Rows.

To configure the type of information to display in each column,
and the number of columns the activity log will have, perform the
following steps:

¢ From the Selected Contents screen area, select each item to
be displayed in the activity log.

e Determine the order the items will appear in the activity log
by highlighting the Selected item and using the Move

Arrows. ')
~—
Note: During this operation, the View Activity Log area of the
screen will be active and will reflect the changes made in the
selection and ordering of the in the items in the activity log.

8-2
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Chapter 8 Editing Preferences

The Preferences menu item provides access to a dialog box that allows
the configuration of the Activity Log , Auxiliary /O Window, Custom
L ) List (Radio), Menu Items, Page List and Speed Dial.

Activity Log
To customize the view of the activity log:

1. Choose Preferences from the Edit menu to open the preferences
dialog box.

2. Select the Activity Log tab.

( ) s M Secure Ke

Resource  Unit Status
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5.

7.

8.

9.
10.

If desired, select the Show Activity Log check box.

o  If checked, the activity log will initially be shown in Dispatch.
If not checked, the activity log will have to be opened in
Dispatch.

If desired, select the Allow Activity Log Modification in Dispatch {1 )
check box. ~—

e  If checked, the activity log parameters can be modified in
Dispatch. If not checked, the activity log cannot be modified
in Dispatch.

To configure the number of rows that the activity log will contain,

select the appropriate nimber from the Total Rows drop-down list.

To configure the type of information to display in each column,
and the number of columns the activity log will have perform the
following steps:

From the Selected Contents screen area, select each item to be
displayed in the activity log.

Determine the order the items will appear in the activity log by
highlighting the Selected item and using the Move Armrows.

Note: During this operation, the View Activity Log area of the ™~
screen will be active and will reflect the changes made in
the selection and ordering of the in the items in the activity
log.

When you are satisfied with the setup of the activity log:

Click OK to accept the changes and close the dialog box.

*  (Click Cancel to close the dialog box without applying the
changes.

e  Click Apply to accept the changes and continue to edit
preferences.

a-2
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8. When you are satisfied with the setup of the activity log:
e (Click OK to accept the changes and close the dialog box.
e Click Cancel to close the dialog box without applying the
; changes.
U s Click Apply to accept changes and continue to edit
preferences.

Auxiliary /O Window

To customize the view of the Auxiliary [/O Window:
1.  Select Preferences from the Edit menu to open the preferences
dialog box.
2. Select the Auxiliary YO Window tab.
This dialog box allows the user to:
e Set the contents of the Auxiliary YO Window.
Set the initial visibility of the Auxiliary /O Window
(Hidden/shown)

Hredetenadd
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To place an Aux I/O group in the Auxiliary I/O Window, select
the group name from the list box and click on the right arrow
button.

¢ The Aux /O group appears in the Auxiliary I/O Window
which is initially maximized to the size of its content and
positioned in the lower left corner of the screen.

To remove an Aux I/Q group from the Auxiliary I/O Window,

click on the left arrow button.

* The Aux YO group is removed from the Auxiliary I/O
Window and the Aux 1/O group name re-appears in the list
box.

Set the visibility of the Auxiliary I/O Window by checking the

Show Auxiliary I/0 Window checkbox

The Auxiliary 1/0 Window can also be hidden and redisplayed via

a toolbar button (see Configuring the Toolbar).

Click OK to accept the changes and close the dialog box.

e Click Cancel to close the dialog box without applying the
changes.

* Click Apply to accept the changes and continue to edit
preferences.
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Custom List (Radio)

In Dispatch, each QuickList can display 2 sets of aliases: Master and
Custom. The Custom List is configured in Admin through the Edit |
Preferences Dialog.

Preferences

To view the dialog to change the Custom List:

1. Choose Preferences from the Edit menu.
2. Click on the Custom List tab.

Editing Preferences 68P81095E70 — G
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To add a new Alias to the Custom List,

1. Two resource lists are available. Select the appropriate list by
clicking on either the Current Configuration or All option

button.

s  If Current Configuration button is selected, then only the . )
currently assigned resources in the configuration file are listed.
Otherwise, all the available resources in the Master Database
are listed.

2. Choose a resource from the drop-down box. The list of aliases
available to this resource are displayed in the Master List,

3. Select the desired alias from the Master List.

4. Click on the right arrow button to add the selected alias to the

Custom List.

e The selected alias is removed from the Master List and is
added to the Custom List.

5. Click OK to accept the changes and close the dialog box.

»  Click Cancel to close the dialog box without applying the
changes.

e Click Apply to accept the changes and continue to edit N
preferences -

To remove an existing Alias from the Custom List,
1. Select the alias to be removed from the Custom List.
2. Click on the left arrow button.

s  The selected alias disappears from the Custom List.

s [f the alias being removed is a valid alias for the currently
selected resource, then the alias appears in the Master List.
Otherwise, the Master List remains unchanged.

3. Click OK to accept the changes and close the dialog box.

s Click Cancel to close the dialog box without applying the
changes.

e  Click Apply to accept the changes and continue to edit
preferences. 3
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Auxiliary I/O Window
To customize the view of the Auxiliary /O Window:

1. Select Preferences from the Edit menu to open the preferences
dialog box.

2. Select the Auxiliary I/O Window tab.
This dialog box allows the user to:
#  Set the contents of the Auxiliary /O Window.

e  Set the initial visibility of the Auxiliary I/O Window
(Hidden/shown)

Preterences

T B

3. To place an Aux I/O group in the Auxiliary I/O Window, select the
group name from the list box and click on the right arrow button.

Editing Preferences E68P81095E70 - G

8-3



4.

click on the left arrow button.

The Aux I/C group appears in the Auxiliary I/O Window
which is initially maximized to the size of its content and
positioned in the Iower left comner of the screen.

To remove an Aux I/O group from the Auxiliary /O Window,

The Aux I/Q group is removed from the Auxiliary I/O
Window and the Aux IO group name re-appears in the list

box.

Set the visibility of the Auxiliary IfO Window by checking the
Show Auxiliary I/O Window checkbox

The Auxiliary YO Window can also be hidden and redisplayed via
a toolbar button (see Configuring the Toolbar).

Click OK to accept the changes and close the dialog box.

Click Cancel to close the dialog box without applying the

changes.

Click Apply to accept the changes and continue to edit

preferences.

84
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Menu ltems

The Edit Menu feature is used to define the contents of the menus that
appear at the top of Elite’s Dispatch screen. There are six menus whose
contents can be defined by the user: Edit, View, Features, Phone, Page
and Folders.

Menu ltems

 Reguest To Telk Window

To change the Menu Items List:

1. Choose Preferences from the Edit menu.
2. Click on the Menu Items tab.

Editing Preferences 68P81095E70 ~ G 8-7



To edit the contents of a menu:

1

2.

3.

Select a menu from the box labeled Menu. This causes its
corresponding menu items to appear in the box labeled Menu
Items.

A checkbox appears to the left of each menu item. A checked O
box beside menu items indicate that they are displayed on the

memi1. Menu Items that are not checked indicate menu itemns

that are not displayed. Disabled (shown as grayed) menu items

are frozen in the selected state, indicating that they cannot be
removed.

Toggle the state (displayed / not displayed) of a menu item by
clicking on its checkbox.

Note: Those menu items that have an associated toolbar button

being displayed on the screen are not allowed to be
removed from the menu. To remove these menu items, first
remove the associated toolbar button from the toolbar.

Note: If a toolbar button is added to the toolbar, then the

corresponding menu item is automatically added 1o the
appropriate menu if not included previously. m

Click OK to accept the changes and close the dialog box. —

Click Cancel to close the dialog box without applying the
changes.

Click Apply to accept the changes and continue to edit
preferences.
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Page List

In CENTRACOM Elite, the Standard Page feature provides the user with
two page lists: Master and Custom. The Custom Page List is configured

U in CENTRACOM Elite Admin through the Edit | Preferences Dizlog. It
should be noted that only one Custom Page List is associated with each
configuration file

i Pieferences

E
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To add a new Name to the Custom Page List:

1. Select Preferences from the Edit menu.
2. Click on the tab for the Page List page.
3. Select the desired Name from the Master List.

¢  The name and associated information appears in the Details
Box.

4. Click on the right arrow button to add the selected alias to the
Custom List.

¢ The selected Name is removed from the Master List and
added to the Custom List.

To remove an existing Name from the Custom Page List:

1. Select the Name to be removed from the Custom Page List.
The name and number appear in the Details box.

2, Click on the left arrow button.

¢ The selected alias is removed from the Custom List and added
to the Master List.

3. Ctlick OK to accept the changes and close the dialog box.
¢  Click Cancel to close the dialog box without applying the

changes.
e Click Apply to accept the changes and continue to edit
preferences.
8-10 68P81095E70 — G CENTRACOM Elite Admin User's Guide
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Speed Dial

In CENTRACOM Elite, the Speed Dial feamre provides the user with
two phone lists: Master and Custom, The Custom Phone List is

U configured in CENTRACOM Elite Admin through the Edit | Preferences
Dialog. It should be noted that only one Custom Phone List is associated
with each configuration file.

ii Preferencns

T e
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To add a Name from the Master Phone List to the Custom Phone List:

1. Select Preferences from the Edit menu.
2. Select the Speed Dial folder tab.

3. Select the desired Name from the Master List. The name and (‘\
number will appear in the Preview Box. ~—

4. Click on the right arrow button to add the selected alias to the
Custom List.

¢ The selected Name is removed from the Master List and
added to the Custom List.

5. Add a new name to the Custom Phone List using the Insert
Button. This allows entry of speed dial aliases that are visible only
to the configuration file where they were entered.

6. Click the Insert button located above the Custom Phone List.
o  The Insert to Custom List screen will open.
7. Enter the new name and number into the appropriate name and

number fields.
8. Click the OK button. This will cause the new name to appear in
the Custom Phone List, o
e  Click Cancel to return to the Preference screen without N
inserting a speed dial alias.

lnsert To Custom Speed Dial List

Note: The maximum number of entries into the Custom List is

1000. '
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Speed Dial

In CENTRACOM Elite, the Speed Dial feature provides the user with

U‘ two phone lists: Master and Custom. The Custom Phone List is
configured in CENTRACOM Elite Admin through the Edit |
Preferences Dialog. It should be noted that only one Custom Phone
List is associated with each configuration file.

Warning: Do not create a Speed Dialing alias name in Elite Admins
Speed Dial Custom List with identical spelling to that
which exists in the ADM.
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To add a Name from the Master Phone List to the Custom Phone List:

1.
2.
3.

Select Preferences from the Edit menu.
Select the Speed Dial folder tab.

Select the desired Name from the Master List. The name and
number will appear in the Preview Box.,

Click on the right arrow button to add the selected alias to the
Custom List.

* The selected Name is retnoved from the Master List and
added to the Custom List.

Add a new name to the Custom Phone List using the Insert
Button. This allows entry of speed dial aliases that are visible
only to the configuration file where they were entered.

Click the Insert button located above the Custom Phone List.
e  The Insert to Custom List screen will open.

Enter the new name and number into the appropriate name and
number fields.

Click the OK button. This will cause the new name to appear in
the Custom Phone List.

e (Click Cancel to return to the Preference screen without
inserting a speed dial alias.

Insert To Custom Speed Dial List

Note: The maximum number of entries into the Custom List is
1000.

8-12
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To remove an existing Name from the Custom Phone List:

1. Select the Name to be removed from the Custom Phone List. The
name and number will appear in the Preview box. Perform either

of the following steps:

e To move the name into the Master List click the left arrow (if
enabled.)

o Click the Delete button to remove aliases entered via the
Insert buiton.

2. To save the Custom Phone List, click the Apply button.
3. To save and exit the dialog box, click the OK button

Setting the Clock

The clock, optienally displayed to the right of the top toolbar, might need
to be set due to:

s power interruption, or
»  during initial system set-up.
To set the clock for the Dispatch system:

1. Log in to the PC which is the Primary Supervisor Operator
position, with the Elite Admin password,

» Ensure that a Dispatch session is running on the PC which is
the Primary Supervisor Operator position. This allows the
time to be controlled by the local PC clock.

2. Change the time on the local PC throngh Windows/NT.

Registry Settings

The Elite application supports several registry values which can be used
to control the behavior of certain aspects of the dispatch interface. The
following table summarizes these values, however, Motorola assumes no
responsibility for user manipulation of the Microsoft Registry.

The key is:
HKEY_I.OCAL_MACHINE/SOFTWARE/Motorola/Console/Elite.
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Name L.t e | -Types Valid Vaiue Explamation . . .
SharedResourceControl REG_DWORD 1 Allow CAD assignment,
0 Not allowed.
RadioPhoneDeassign REG_SZ Deassign All Deasslgn all radio and phone Y
resowrces
Deassign None Deassign no radio and phone
resources
Deassign Elite Deassign elite assigned radio and
phone
AuwdoDeassign REG_SZ Deassign Alt Deassign all Auxiliary /O
resources
Deassign None Deassign no Aindliary VO
resources
Deassign Elite Deassign elite assigned Auwxiliary
O only
ConfigPath REG_5Z No restriction Default path of configuration file
Status Line\Width REG_DWORD No restriction Status Line width
Status Line QueueSize REG_DWORD No restriction Status Line queue size
Safety SwitchUnlockDuration REG_DWORD No Rastriction Determines the length of the safety
Switch unlock timer in seconds. It
also determines the length of
delete stack entry and delete entire
stack activation in seconds.
PagingResendTimeout REG_DWORD No Restriction Determines the length of time
before resend button of paging \
changes back to send i it is not
pressed. i
HysteresisX REG_DWORD No Restriction The hysteresis variable for the
resource tile for the X component.
This controls how far the user must
drag the resource tile before it will
rmove on the dispatch screen
Suggestion minimum 5.
HysteresisY REG_DWORD No Restriction The hysteresis variable for the
resource tile for the Y component.
This controls how far the user must
drag the resource tlle before it will
move on the dispatch screen.
Suggestion minimum 5.
LargeFolderTabSize REG_DWORD 50 < x < screen The width of the folder tab for a
resolution / 6 “Large” setting
MediumFolderTabSize REG_DWORD £0 < x < screen The width of the folder tab for a
resolution / 6 “Medium” setting
SmaliFolderTabSize REG_DWORD 50 < x < screen The width of the folder tab for a
resolution /6 “Small” setting.
MomentaryToneDuration REG,_DWORD >0 Determines the duration in seconds
that Elite will filter out duplicate
type of Momentary Tones. f \
Activityl ogPath REG_SZ No restriction Path to the log file of the Activity

Log

Dispatch Interface Registry Values

&14
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To remove an existing Name from the Custom Phone List:

1. Select the Name to be removed from the Custom Phone List. The
name and number will appear in the Preview box. Perform either of
the following steps:

s To move the name into the Master List click the left arrow (if
enabled.)

s  Click the Delete button to remove aliases entered via the Insert
button.

2, To save the Custom Phone List, click the Apply button.
3. To save and exit the dialog box, click the OK button

Setting the Clock

The clock, optionally displayed to the right of the top toolbar, might need
to be set due to:

*  power interruption, or
s  during initial system set-up.
To set the clock for the Dispatch system:

1. Log in to the PC which is the Primary Supervisor Operator
position, with the Admin password.

o Ensure that a Dispatch session is running on the PC which is
the Primary Supervisor Operator position. This allows the
time to be controlled by the local PC clock.

P Change the time on the local PC through Windows/NT.

Registry Settings

The Elite application supports several registry values which can be used
to control the behavior of certain aspects of the dispatch interface. The
following table summarizes these values.

The key 1s:
HKEY_LOCAL_ MACHINE/SOFTWARE/Motorola/Console/Elite.
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Name Type Valid Value _Explanation

SharedResourceContro | REG_DWORD | 1 Allow CAD assignment.

) O Not allowed.

RadioPhoneDeassign REG_SZ Deassign All Deassien all radio and phone resources

Deassign Deassign no radio and phone tesouwcr- \

None

Deassign Elite | Deassign elite assigned radio and [
phone

AuxioDeassign REG_SZ Deassion All Deassign all Auxiliary /O resources

Deassign Deassign no Auxiliary O resources

None

Deassign Elite | Deassign clite assigned Auxiliary V'O
only

ConfigPath REG_SZ No restriction | Defanlt path of configuration file

Status LineWidth REG_DWORD | No restriction | Status Line width

Status Line QueneSize | REG DWORD | No restriction | Status Line queue size

SafetySwitchUnlockD | REG_DWORD | No Restriction | Deternines the length of the safety

uration Swatch unlock timer in seconds. It also
determines the length.of delete stack
entry and delete entire stack activation
in seconds.

PagingResendTimeout | REG_DWORD | No Restriction | Determines the length of time before
resend button of paging changes back
to send if it is not pressed.

HysteresisX REG_DWORD | No Restriction | The hysteresis variable for the resource
tile for the X component. This control/ \
how far the user must drag the resource~~
tile before it will move on the dispatch
screen. Sugpestion minimum 5.

HysteresisY REG_DWORD | No Restriction | The hysteresis variable for the resource
tile for the Y component. This controls
how far the user must drag the resource
tile before it will move on the dispatch
screen, Sugeestion minimum 5.

LargeFolderTzbSize REG_DWORD | 50 < x <screen | The width of the folder tab for a

resolution / 6 ] e” setting

MediumFolderTabSize | REG_DWORD | 50 < x < screen | The width of the folder tab fora

resolution / 6 “Medium” setting

SmallFolderTabSize REG_DWORD | 50 < x <screen | The width of the folder tab fora

resolution / 6 “Small” setting.

MomentaryToneDarati | REG_DWORD | >0 Determines the duration in seconds that

on

Elite will filter out duplicate type of
Momentary Tones.

Dispateh Interface Registry Values

)
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Chapter 9 Troubleshooting

This section lists problems that may occur with CENTRACOM Gold
Series Elite and suggests corrective actions. If the supervisor is unable to
solve the problem, refer to the “Getting Help” paragraph in the Foreword
section for instructions on contacting the System Support Center.

If the PC screen “freezes” and does not respond to the keyboard or the
mouse, reboot by pressing the Control, Alt, and Delete keys
simultaneously. Admin must be restarted after the reboot.

If the problem recurs, notify the supervisor.

If the PC is powered up, but there is no display on the monitor, ensure
that the monitor cable is securely plugged into the back of the PC and the
monitor. Ensure that the monitor’s power cord is securely plugged into a
120 VAC, 60 Hz grounded power outlet.

If there appears to be a problem with the PC itself, refer to the manuals
that came with the PC.

Error Messages

Error messages are displayed in the status line located at the bottom of the
Dispatch desktop. Most error messages which may occur during Dispatch
operation are self-explanatory. Some error messages instruct the operator
to contact the system administrator and occur if the operator attempts an
action that is not possible at the time.

When debugging a problem, check this list first. If the problem still exists,
contact the System Support Center. The paragraph entitled “Getting
Help” in the Foreword provides instructions for contacting the System
Support Center.

Internal database error contact sys admin

The properties on the master database may be set incorrectly. Find the
master database file by looking up the path using the CENTRACOM
Gold Series Configuration program, and make sure the file properties are
not set to Read Only. Also, make sure no one else is running the Console
Database Manager program at another PC using the same master
database.
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Not ready - can’t find database: contact sys admin
Elite cannot find the local database on this PC. Run the CENTRACOM
Gold Series Configuration program, and re-install “Elite Support”.

Not ready - link between the CIE/speakers and CEB is down

Make sure that the cable between the CIE and the CEB is securely m
plugged in and that the CIE is powered up. Also make sure that the ~—
diagnostic LED on the COIM board for this operator position is currently
green, If the COIM is not green, please refer to the COIM maintenance

guide for assistance.

Not ready - link between the PC and CIE/speakers is down

Make sure that the cable between the PC and the CIE is securely plugged
in and that the CIE is powered up. Ensure the cable is plugged into the
correct serial port. The serial port being used can be checked and changed
using the CENTRACOM Gold Series Configuration program.

OP is not ready for use: contact sys admin

The operator tried to perform an operation while the console was not
ready. Look in the error history of the console that had the error, and look
for an error that begins with “Not ready.” Take appropriate action based
on that error message.

“Resource” not assigned - exceeded max assignments: contact sys 5
admin -
Either increase the number of allowable assignments in the CDM for this
operator position; remove some resources from the configuration file; or
instruct the operator not to assign any new resources.
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System Errors

System errors are indicated by the presence of a gray exclamation point
on a red background displayed in the lower right-hand corner of the
Dispatch screen. If a system error occurs on an operator’s console, check
the fault maintenance printer for details on the error.

To clear a system error in Dispatch, choose the Clear System Error
toolbar icon, or choose Clear System Error from the Options menu.

System could not be initialized properly because of a datahase
misntatch error. Please contact the system administrator.

The PC may be connected to the wrong COIM board in the CEB. Check
the Time Division Multiplexing (TDM) slot setting for this PC in the
CDM, and verify that the DIP switch settings on the COIM board are
correct.

System could not be initialized properly because of 2 network
communication failure. Please contact the system administrator.
The local area network is down. Check to make sure all network cables
are securely plugged in. Check all network hardware to make sure it is
powered up and running.

System could not be initialized properly because the database could
not be found. Please contact the system administrator.

The master or local database was moved after iritial installation. Verify
that the CENTRACOM Gold Series Configuration program points to the
correct location for the master database. If this parameter is correct,
reload the local database by re-installing “Elite Support.”

System could not be initialized properly because the database
software is out of date. Please contact the system administrator.

The local and master databases for the system are not in sync. Either the
master database was upgraded to a new version and the local wasn't, or
vice versa. Make sure all the local and master databases were loaded from
the same version of the CENTRACOCM Gold Series Configuration
program.
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TERM DEFINITION

ADM Alias Database Manager - A CENTRACOM Gold Series application program
that configures aliases for subscriber radio units, status and message numbers,
and phone numbers.

ADMI Alins Database Manager Intcrface - This card interfaces to the CEB in Classic
systerns to program the alrases.

AEB Ambassador Electronics Bank - Large audio switch that can interfacc up to 32
CEBs or channel banks.

Aliasing The console feature that allows the nsers to assign names to trunking talk
groups, unit IDs, or BIMs. For more information, refer to the Alias Database
Manager User's Manual (68 P8 1096E50).

All Mate A feature which mutes all unselected audio, allowing the operator to hear the
select audio more clearly.

All Mute Delay The delay between the time the all mute feature mutes the speakers and the
time that the normal volume is restored. The default is 30 seconds. It can be
changed to any time from 1 to 255 seconds.

All Mute Level The output level for the audio when the ALL MUTE feature is invoked. The
default is 42 dB. This can be changed to 0 dB, 6 dB, 12 dB, 18 4B, 24 dB, 32
dB, and 36 dB using CDM. |

API Application Progrem Interface - APl is the software interface for the Elite
positions.

Asblown The printout produced by the Trunked CENTRACOM Field PROM
programmer which describes the configuration of the console,

Asbuilt Fhe printout produced by the factory which describes the configuration of the
console.

Assignability The console feature that allows CCMs to be dynamically assigned to specific
channels.

Assignable A feature which permits the assignment of specific channel audio to auxiliary

Speakers speakers.

ASYNC Asynchronous - A type of protocol that is used in the Gold Series.

Audible Alarm A loud tone generated by the console to indicate that an event has occurred
which requires the operators mmmediate attention. Sometimes referred to as
sonalert.

Automatic An option which causes the idle trunking central controller to become active

Switching automatically when the console determines that there 15 a failure in both data
links to the actrve trunking central controller.

Auxio Auxiliary I/O line on a2 CEB board - An auxihary output can be activated by a
CCSM closure. An auxiliary mput can be routed to light a CCSM LED.

Auxio Card The card installed in the CEB above a BIM, TRIM or DR to buffer zuxios.

Auxio Safety A safety switch which prevents the operator from accidentally sclecting an

Switch auxio.

Base Stations The repeater which 1s the source of andio recetved by the console, and the
destination of audio transmitted from the console,

Baud Rate Number of bits transferred per second,

Glossary

6BPBI095ETD -G Glossary - 1




TERM DEFINETION
BID Code Bese ID Code - The code used to identify a talk chammel.
Busy/Callback In trunking and iDEN systems, if all repeaters are busy, and an operator
attempts to make a call, the console provides a busy indication and alerts the
operator when a channel becomes available.
Busy Override A trunking feature that allows one operator to take control of a resource from ri-\
another operator.
CAD Computer Aided Dispatch - Console feature that allows dynamic
reconfiguration of the system via a computer.
CAD Host The computer system that supports the CAD system. May be connected to the
console via a CAD interface or the Elite APL
Call Alert A signaling feature which perrmuts the operator to send an alert tone to a radio,
alerting its user to call in to the operator.
CCM Channel Control Module - The hardware module on a Classic Buttons and
LEDs or Classic Conpact operator position containing eight switches, which
generally control one or two channels. There are eight CCMs on a CCP.
CCP Channel Control Panel - One of the panels containing space for eight CCMs on
the operator position of a Classic Buttons and LEDs.
CCSM Channel Control Switch Module - One switch/LED combination on an
operator position.
CCW Channel Control Window - Used on Classic CRT for cach channel/talk group.
CDM Console Database Manager - A CENTRACOM Gold Series application
program that permits reconfiguration of a control center.
CEB Central Elcctrontes Bank - A rack or multiple racks of card cages containing
the circuit boards which are connected to a common TDM bus. -
Central Switch The mechanism by which the console switches contral controllers m trunking £ )
systems. - e’
CENTRALINK A 911 system user interface that can run on the same PC as CENTRACOM
2000 Gold Elite.
Channel Disable A supervisory feature which permits the supervisor console to disable specific
channels at another console.
Channel Marker The configurable featurc that causecs a half sccond tone burst to be transmitted
(Priority) on a sclected channel every 10 seconds to 1dentify that channel as a priority
channel. Note: Channel Marker does not work on all system types.
CIE Console Imerface Electronics - This is used with the Classic CRT and Elite
dispatch positions. The CIE contains speakers, vu meier, and a front panel
transinit switch.
Clock Display The central display on the masier control pancl. The time is sct by the
supervisor and the clocks at all othet operator positions are then synchronized.
The clock display is also used for task-specific displays.
COM Console Opcrator Interface Module. - The CEB board that interfaces to
aperator positions in the CENTRACOM Gold Senes system.
Common Database | Databases that must be the same in all the COIMs 1n the system.
Conditional The console kecps track of the number of channels that are active on both
Switching trunking centrals in a SMARTNET system. The conditional switching option ﬁ
causes the consolc to deny any attempt to switch to a central with fewer f
channels active, —
Console A console is made up of one or more operator posittons and a CEB.
Conventional A non-trunked channel; 2 channel that always transmits at 2 specified
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Channc] frequency.

Conventional A basic radio system, without trunking capability that transmits voice and

Systems limited data.

Data Logger A data logger records console data. It can be used with signaling systems only.

Database File containing theconsole system configuration data

DCCM Display CCM - CCM with an 8-digit 5 x 7 dot matnx display, and four LED
annunciators, for displaying data.

De-Assign The ability to unassign a channel.

Dedicated Auxios Auxios which perform a function related to the channel for the BIM they are
assigned to. Examples: Mam Standby, Supervisor Takeover. Dedicated auxios
are always assigned to the same auxio number.

Dedicated Fallback | CCM which is only used in fallback mode.

CcCM

Dekey Stop transmitting.

Download Transfer data to the personal computer’s disk throngh the local area network.

DPl1 Direct Phone Inteface - A BIM which interfaces to 2 phone line. Allows the
operator to answer or initiate a call on a telephone line.

DPL Digital Private Line - This is a squelch type that can used by incoming
subscribers or base stations.

DR Dual Receive board - A board in the CEB which interfaces with 2 basc station
reccive channels. A DR takes up two TDM slots.

Duplex Simultaneous two-way audio.

Duplex Patch A patch wherein communication can occur in both directions at the same time.

Duplex Patch The interval between the time that the activity on a patch stops, and the time

Dropout that the channel dekeys. The default vahue is 5 seconds as opposed to 3 sccondy
to dckey a channel normally. This can be changed to any value from 1 to 255
seconds.

DvP D:gital Voice Privacy encryption - Base station feature which encrypts audio
for privacy.

Elite Graphical Uscr Interface for dispatching on the CENTRACOM Gold Series.

Embassy System A radio system that has a capacity of mare than 96 channels. An Embassy
system can be trunking or conventiona), and may or may not be equpped with

signaling capability.
Emergency An operator position uses emergency acknowledge to inform parallel operator
Acknowledge positions that the emergency is being handled.

Emergency Reset After an inbound emergency call is received, the operator must reset the
emergency indicator on the DCCM.

Enter ID Permits the operator to eater the 1D of a single radio and transmit a signal to
only that radio. Enter ID is used with signalling systems only.

Failsoft Mode Operation of the trunking system when the SmartNet trunking central
eontroller is not operational. One repeater is designated for each talkgroup to
use during failsoft mode.

Fallback Mode The mode entered when the link to the Classic CAD host fails.

Fallback Status Status for each assignable channel which denotes one of three possible courses

of action during fallback mode: keep the current assignment, revert to the
fallback CCM, or deassign the current assignment,

FILO First In Last Out.
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Footswitch

A pedal-operated switch located on the floor beneath most consoles. Pressing
the right pedal is equivalent to pressing the Transmit bar on the console.
Pressing the left pedal is equivalent to pressing the Monitor switch.

Frequency Select

In a multi-frequency base station, this feature allows the console to sclect the
desired Transmit/Receive frequencics.

ﬂ

Group Page Several radios can be grouped and paged simultaneonsly.

Group/Regrouping | In trunking systems, radios are assigned to talkgroups, and the trunking central
controller assigns channels to the talkgronps as required. Group Regroupng is
a feature that permits several talkgroups to be combined into a multigroup
using the multiselect or patch feature.

ICOM Intercom Interface.

Inbound A feature that allows a radio to transmit an emergency signal to the console in

Emergency signalling or trunking systems.

Individual ID ID of a radio or console in a talkgroup.

Instant Transmit A feature that allows the operator to transmit to an unselected resource. Each
channel has its own Instant Transmit switch.,

Intelligent Call Intelligent Call LED shows 2 different indication for calls on chanmels/talk

LED groups that are not sclected anywhere on the console.

Intercom A feature which permits voice communication between consoles,

Interiocked Auxios | Only one interlocked auxio can be chosen at a tume; choosing one releases
another,

Kbps Kilobits per second. This is a signaling ratc.

Keying Turning on a repecater.

Local Auxios Auxios on 2 COIM which arc only used on the operator position connected to
the same COIM. f

mA milli-Amps.

Mam/Alternate A feature which allows for manual or automatic switching between two Base
Interface Modules (BIMs).

Main/Standby This feature allows the operator to manually choose to use a standby repeater if
the main repeater fails.

Mbps Million Bits Per Second.

MCP Master Control Panel.

MDC (a.k.a. Motorola Data Commumcationsignatiing format supperted by the conscle.

STAT-ALERT)

Mic Microphone.

MID code Module 1D Code - Every board in the CEB that does not have a BID code has
an MID code. MID codes start with a letter indicating the type of board it
belongs to, followed by a 2-digit decimal pumber.

Momtor This feature temporarily suppresscs the squelch on a muted channel, so the
operator can monitor the channe! for call activity before transmitting on it, thug
preventing the operzator from interrupting a call in progress.

MSEL Multiselect.

Multigroup Two or more talkgroups can be combined into a multigroup in trunking
systems, Calls to the multigroup reach all members of the talkgroups included
in the multigroup.

Multigroup A channel that transnuts to 21l groups in a multigroup.

Channel
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Multikey Using Multiple Encryption Keys on a secure channel is called Multikey.

Multiport Having multiple ports on a controller is called Multiport.

Multi-select A method of combining several radios into a group so that afl can be called at
once.

Mute Second This is a function that mutes the second receiver on multirecciver base stations

Recewver {T22R, T44R).

OMI Muting A signaling feature which mutes Stat-Alert data barsts from berng heard at the
dispatcher's speakers.

Cperator Disable A supervisory feature which permits the supcrvisor console position to disablc
another console position.

Operator Position The interface to the operator.

OPs Operator Positions.

Page Safety Switch | Prevents accidental pages from the console. The safety switch must bergssed
before sending a page.

Paging The ability to send paging tonesover the air

Paging Pisable A supervisory feature which permits the supervisor console to disable paging
capability at another console. Classic systems only.

Patch A console feature that permits resources of different types to commumicate
directly.

Patch Idie Delay The amount of time when there is no activity on a patch before the patch
ACTIVEADLE LED flashes. The default is 30 secands. It can be changed to
any value from 1 to 255 scconds.

Patch Sctup The process by which the operator places resources into a patch.

Patch Transmit The act of transmitting to all patch members from the console,

Personality The specific customer configuration of the console.

Phone Patch A BIM which mnterfaces to a phone line rather than a base station. Allows
patches between phone lines and radios.

PL Strip A BIM option which allows paging without PL (Private-Line Coded Squelch).

Positive Mode This is uscd to key the DIU/CIU or basc station when encryption is usedin a

Control Gold Series Console.

Primary Resource | A radio resource selected by an administrator as high priority, designated on
the resource display with a diamond symbol.

Primary Supervisor | The consolc position with the highest transmitting priority, and the ability to
use supervisory features.

Private Call A type of ttunking channel used to talk to one individual radio,

Private Line Private Line - This is a squelch associated with subaudible tones.

PROM Programmable Read Only Memory.

PTT - (Press To Another term for keying up a radio.

Talk)

PTTID A signalling featurc that causes the ID of a radio to be displayed on the channe]
when the radio keys up.

Public Address The ability to address an overhead paging system.

Radio Check A signaling feature that allows the operator to check on whether an individual
racho 1s operating.

Radio A, signaling feature which allows the console operator to remotely turn on a

Enable/Disable radio and cause 1t to transmit audio. If the radio has been lost or stolen, the
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TERM DEFINITION
operator can use radio disable to prevent misuse of the radio by unauthorized
petsons.

RCM Radio Control Module - The control module containing the clock and keypad.

RCP Radio Control Panel, - The lowest numbered CCP which contains the RCM.

Recall Recorder A recorder hooked up to the console which records callfor an op posihon /

Regroupable A talkgroup is regroupable if it can be redefined with another talkgroup into a |
multigroup during 2 patch or multiselect operation, and using one repeater.

Relay Keying An option to a BIM in which a relay 1s uscd to key the base station.

Control

Remote Monitor A signalling feature which allows the operator to remotely key a radio without
alerting its user.

Repeater Enable This enables/disables the repeat mode of a base station.

Resource A generic term that refers to radio channcls and phone lines connecied to the
CENTRACOM Gold Series console.

RF Radio Frequency.

Secondary The consolc position with the second-highest transmitting priority

Supervisor

Select Choosing a resource by pressing its Select switch routes audio to select
speaker.

Select Audio Aundio routed to a select speaker.

Select Speaker The console speaker through which the audio of the selected resource(s) is
heard.

Selective Call A call whrch is directed to either a smgle radio or a group of radios. Sce call
alert or voice alert,

Sclf-Repeat Also referred to as Talk-Through - Allows the Repeat path to be enabled.

Sequential Paging | Sequentially sending out pages {Check List Paging).

Senal Link Baud The baud rate of the hink from the COIM to the operator position.

Rate

Signalling The ability to send data on a conventional channel to support signalling
features such as PTT ID

Simplex Muting Muting Avdio on a simplex channel.

Simplex Patch A patch wherein communication can occur 1n one direction at 2 time.

Single Tone An audible tone to control subscriber access to a repeater (similar to PL).

Sitewide A fell back mode in SmartZone radio systems.

Smplx Simplex~ Radio communication is transmitted and received on one frequency.

Sonalert The console audible alarm, which indicates that an cvent has occurred which
requires the operators immediate attention.

SP Special Product - A special enhancement to the Gold Scries system that is not
standard.

SPI Smart Phone Interface.

Stack Delete The feature which clears the recerve ID stack in a DCCM.

Stacking The ability of a DCCM to store up to 10 receive IDs 10 memory.

Stat-Alert Preamble Signaling at the start or end of an audio transmission. Same as
MDC1200.

Status/Message A signaling feature which sends a status or message to a dispatch position.
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Only available on Ciassic Buttons and LEDs and Elite GUL
Status Request A signaling feature which requests the status of a subscriber unit.,
Supervisor Status The supervisory level for cach eperator position. Primary, secondary, and non-
supervisor are the different supervisory levels.
Supervisor A switch on the operator position which controls an auxio on a BIM which
Takeover inhibits T1600 or Series 90 type controllers from using a base station.
Supervisory Console capabilitics that can be performed at the supervisory console only.
Capabilities
SYNC Synchronous - A type of data transmission protocol.
System ID The trunking system ID as it is known to the trunking central controller.

System-related K
Options

K options which are associated with a trunking system ID, such as central
switch buttons.

System-wide A channel whose talk group is the whole trunking system.

Channel

Takeover Takeover refers to a dispatcher taking over a subscriber's audio transmission.

Talkgroup A subgrouping of the channels in a trunking system,

Talk-Through Also referred to as Self-Repeat, allows the audio to be repeated in a basc
station.

TBIM Trunking Base Interface Module - A BIM for trunking channels.

telco Telephone company.

Terminal Baud The baud rate of the diagnostic terminal link.

Rate

TonR A single-transmitter, with multiple receivers, n indicates the quantity of
frequencies.

TnRn A single transmitter and single receiver, n indicates the quantity of frequencies
in the base station.

TRACKBALL A peripheral device used to point the cursor on a Classic CRT or Elite console.

Transmit To originate a call to sclected resources, gither from the console or from a
radio.

Transmit Priority The ability of a higher-pnority operator or transmission to take over a channet
from a lower-priority operator or transmissjon.

TRC Tone Remote Control - This is used to remotely control a tone remote basc
station.

Trunking A method of allotting a Limited number of channels to many radios, based on
the principle that not all radios are in use at the same time. In trunking systems
the tnunking central controller assigns channels teadios as required,

Trunking Central The controller hardware which coordinates trunking repeater assignments. The

Controller TIMI interfaces directly to the trunking central controller.

Trunking Channel | A channel that 15 part of a trunking system. It 15 not associated with a parnculag
base station since it can be allocated dynamically to any base station in the
trunking system which the channel belongs to.

Trunking The system, group, and talkgroup that a trunking channe] belongs te.

Talkgroup

UNSELECT Unselect audio is usually non-working dispatch channels going through the
unseleet speaker.

Unselect Speaker The censole speaker through which all but the selected audio 1s heard.
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Voice Alert A signalling calt type sent to a radio to alert the user that a voice call from the
console is being sent. This is useful if the radio user is out of the vehicle and
cannot hear a voice call.

Voting Comparator | A device which compares the received signals from two difftrent receivers and
seleets the stronger of the two. ,

VOX Voice detection - This is used to indicate call indication. J

Wildeard Wildcard tones can be sent fo the base station to perform certain functions.

Xmit Transmit.

zc Zone Controller
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